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The Evolution of Video Editing 
 

Soviet director Sergei Eisenstein making edits with scissors. 
Image courtesy of Senses of Cinema. 
All video editing during the industry’s nascent period was 
through a process known as linear editing, a destructive 
form of editing performed sequentially in the order of the 
final edit. While linear editing is still performed today, it has 
largely been replaced by non-linear video editing (more on 
this later). 
 

• 1890: The Kinetograph, the first-ever motion picture camera, is developed by Thomas Edi-
son and trusted assistant William Dickson. It films with celluloid at around 40 FPS. 

• 1894: The Edison Vitascope, which includes a projector, debuts in the U.S. Film exhibitors 
begin arranging one-shot films into coherent programs using the technology, described as 
“a primitive form of editing”. 

• 1900s: The first-ever cuts are made with scissors, tape, and editing tables (by the 1950s, 
tape will eventually be replaced with film cement). Because editors still can’t even view 
their films while editing, they’re forced to hold strips of film up to the light to make their 
cuts. 

• 1916: The Technicolor color process makes its debut. By this time, film editors have begun 
experimenting with other color processes and rudimentary special effects. 

• 1924: The Moviola—the first video editing machine—is introduced, allowing editors to, for 
the first time, make edits while simultaneously viewing their film. 

• 1934: The Academy Awards present the first-ever Os-
car for Best Film Editing (awarded to Conrad A. 
Nervig for the movie “Eskimo”). While not a techno-
logical or process advancement, the recognition 
raises the profile of film editing within the industry 
and for the general public. 

• 1950s: Flatbed editing tables, such as the Steenbeck 
and Keller-Elektro-Mechanik (KEM), are introduced as 
an alternative to the Moviola. These tables feature a 
series of rollers and motorized plates. Film splicing 
machines, such as the Ciro Guillotine Tape Splicer, also make an appearance in the 1950s.  

The Emergence of Videotape 

Everything changed with the invention of magnetic videotape, favoured by the TV indus-
try thanks to its relative convenience and low cost, in the early 1950s. Videotape also 
provided other advantages over film; it uses the transverse scan method (which records 
on the full width of the tape), which allows more data to be stored on the same amount 
of physical tape, resulting in a lower required tape speed. 
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• 1950s: Ampex Corp. unveils its Video Tape Recorder (VTR), the first machine to use mag-
netic tape to enable the recording and editing of video. The Ampex VRX 1000, which cost a 
princely sum of $50,000 USD at the time, is the first commercially successful videotape 
recorder and uses a 2″ Quadruplex format. 

• 1961: The EECO 900 electronic editing controller becomes one of the first pieces of video 
editing equipment to utilize timecodes (a new feature of videotape at the time). 

• 1963: Ampex EDITEC electronic editing is introduced, allowing the editing of video without 
physical cutting or splicing. 

Enter Non-Linear Video Editing 

The concept of non-linear editing—which allows video editors to change any part of a video, no mat-
ter if it’s at the beginning, middle, or end of the project—first appeared in the early 1970s. Unlike lin-
ear editing, non-linear editing helps prevent generation loss and doesn’t require the original film or 
video to be altered in any way. 

• 1971: The CMX 600, also known as a RAVE (Random Access Video Editor), becomes the 
world’s first computer-powered NLE. It stores data digitally, costs around USD$250,000, 
and its disk drives are the size of domestic washing machines. 

• Late 1980s/early 90s: The advent of digital NLE software such as Avid Media Composer 
and Adobe Premiere marks the beginning of modern video editing, transforming the edit-
ing suite from a studio address to anyone’s home or laptop computer. The first iteration of 
Avid supports resolutions of up to…640×480? 

• 2000s: Improved processing power and multicore CPUs give personal computers the 
power to edit video using higher and higher resolutions, while new editing software such 
as DaVinci Resolve and Final Cut Pro provide even more options for video editors. 

Present-day video editing 

Today’s marketplace is dominated by non-linear video editing software combined with powerful digital 
cameras and technology-driven workflows. These tools have been further augmented by relatively 
new innovations such as artificial intelligence (AI) and machine learning (ML) automation, cloud ca-
pabilities, and the ability to handle larger and larger files within the editing suite. 
Offline vs. Online Editing 
Non-linear editing since the early days was traditionally synonymous with “offline editing”, which 
requires editors to transcode lower-resolution copies of raw footage to serve as proxies during the 
editing process. That’s because these raw files were, in most cases, too large and cumbersome for 
contemporary tools to work with. 
With the rise of more powerful NLE’s, however, offline editing has become less of a requirement. 
Applications such as Premiere Pro and Final Cut Pro X can now work with massive raw files, as long 
as your computer can keep up. Other software-as-a-service (SaaS) video editing tools allow for huge 
files by harnessing the virtually limitless computing power of the cloud. 
AI/ML video editing tools 
Because technology just keeps on rolling, some NLE’s now come outfitted with ML-driven automa-
tion for even more efficient video editing. The video review below from the Learn How to Edit Stuff 
YouTube channel shows how Runway ML uses machine learning to allow single-click masking and 
auto-rotoscoping with no cuts (as opposed to the typical tedious, frame-by-frame process). All ro-
toscoped footage can then be exported as chroma key colors, alpha channels, or video. 
Reviewer Ian Sansavera says the software’s ML technology enabled him to rotoscope a clip in “1/24th 
the time” as with manual video editing software, though admittedly the latter offers more control 
choices such as feathering, contrast, shifting, motion blur, and decontaminating edges. 
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Read More: Why Ian Sansavera, from Team Liquid chose MASV above all other file transfer solu-
tions  
Other video editing software that take advantage of AI tools include: 

• Kamua: A SaaS tool that uses computer vision algorithms to provide several automated 
tools, including AutoCut (AI-driven shot detection) and SmartCrop (AI-driven video crop). 

• NAÏVE: Uses AI to analyze all your footage, remove low-quality clips, and automatically 
sequence the footage within Premiere Pro. It can also auto-sync audio and video. 

• PluralEyes: Similar to NAÏVE, PluralEyes uses automation to quickly synchronize audio 
and video. It provides instant feedback through color-coded visuals on the NLE timeline as 
footage synchronizes. 

• Descript: Auto-transcribes video into text, allowing you to edit video simply by cutting, 
tweaking, or rearranging the text in your transcription.  

Mainstream video editing software has also gotten into the AI game recently. Final Cut Pro X of-
fers ML-driven auto video cropping by analyzing clips for “dominant motion”. And Premiere Pro now 
offers several automated features including Color Match (instant color matching), Morph Cut (for 
more seamless transitions in interviews), Scene Edit Detection (automatically finds scene transitions 
and places the cuts), and Auto Reframe (removes the need for manual keyframe motion edits by au-
tomatically identifying the video’s focal point when reframing). 
Mobile and the Further Democratization of Video Editing  

The rise of mobile video editing apps just might be the great-
est thing to happen to creators since YouTube. These apps 
make video editing a more lightweight, convenient experience 
available to anyone with a mobile device. It’s a whole lot eas-
ier to download an app than spend hundreds of thousands on 
editing equipment, after all.  
Mobile video editing apps are also typically far easier to use, 
with much a lower barrier to entry, than full editing suites. 
We’ve already taken a spin through some of the best free mobile video editing apps. But there are 
other options out there, including: 
Adobe Premiere Rush: Made for social media creators whipping up content on the fly, Premiere Rush 
automatically converts videos to fit the required specifications for various social media channels. Us-
ers can tailor transitions, customize titles, apply color correction, add audio, and adjust video speed, 
among other capabilities. 
LumaFusion: Marketed more to mobile journalists, filmmakers, and pro video producers, LumaFusion 
offers multitrack video editing on the go (featuring six video/audio tracks and six additional audio 
tracks). 
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What to consider before you start editing videos 

The editing process begins before you even fire up your computer and editing 
software. Think about what your edit will need while you’re shooting. Better 
yet, think about your edit before shooting.  

Making a plan via a shot list or even just a general outline of what you 
want to capture will help you shoot what you need to make your vision 
come to life. Trust us, if you get organized before shooting, you’ll thank 
yourself later. 

Shoot enough to edit well 

Getting more than enough footage for your edit is something video editors call coverage. It’s the best 
way to avoid trouble during the edit — or worse, having to go back to reshoot.  

Here’s how you can cover your bases when shooting: 

• It takes two (or more) takes. Gone are the days of running out of film; hard drives are cheap and 

abundant. Use the extra space to record multiple takes, or versions of a scene. That is, always 

shoot more takes than you think you need. This will give you more options to work with when in 

the editing suite. It’s always better to have too much footage than not enough. 

• Let the record show. For the same reason you want more than enough takes, you also want your 

take to run longer than you need. Start recording a few seconds before the action, and keep 

shooting for a few seconds afterward. Those extra seconds will give you room to cut in and cut 

out at the right moment. 

• Don’t stop ’til you get enough. Regardless of the shot, always shoot for at least 10 seconds. This 

general rule applies even if the action lasts only a couple of seconds, or if you’re recording a 

static shot with no actions. Even pressing the record button or stepping back from the camera 

can cause vibrations or sounds. Recording for 10 seconds gives your equipment enough time to 

stabilize and guarantees a minimum amount of usable footage. 

• Read the room. Every recording environment has a certain audio quality when no one or nothing 

is making a sound. Professionals call it room tone — background sound, the sound of the room, 

or the sound of silence. Collect a bit of room tone from every location. It could be useful for fill-

ing awkward audio gaps in your edit later on. 

11 basic video editing principles 

There’s no one way to edit videos. Your approach will depend on your project and your creative prefer-
ences — but there are a few tried and true strategies that can streamline your workflow and, hopefully, 
spare you from having to learn the hard way.  
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Here’s a step by step beginners guide to editing video footage: 

1. Organize your footage 

“You have to be organized,” says Tiff Bauer, former video producer at Descript. “Starting off by organizing 
your stuff straight out of the camera is great.”  

Keeping your video clips and audio files in order will allow you to quickly find the pieces you need when 
you need them. Decide on a management strategy and file structure, and keep it consistent.  

Create folders for your project on your device and make subfolders for your raw clips depending on their 
type, or where they belong in your edit.  

2. Make a plan 

It doesn’t have to be overly elaborate, but you should have a good idea about what your project will look 
and sound like. Create an outline of your vision, or better yet, make a shot list detailing the visual and the 
audio components of every scene.  

If you want to include voiceover or narration, write a script by outlining the points you want to make, then 
writing them out to sound natural. Read it out, make adjustments, and repeat until it sounds right. Keep 
your writing concise, and make sure that whoever is reading the script practices in advance. 

3. Choose clips that show important action 

Trim clips to include only the parts you need. Ask yourself: What does my story need? “You don’t have to 
keep everything,” says Tiffani. “If it’s not working in the edit, feel free to drop it.” It’s normal to be precious 
about your footage, especially if it took a lot of work to record, but a good editor can make tough choices 
for the sake of the overall project. 

4. Use establishing shots  

Viewers like to feel situated. While close-up and medium shots show action up close, they often leave 
out the characters’ (or subjects’) environment. An establishing shot shows a scene’s wider context, al-
lowing your viewers to understand where everything fits, helping immerse them in the setting.  

5. Use match cuts 

One way to make your edits less apparent and create continuity is to use what the pros call a match cut. 
“A match cut is when you cut from one clip to another by matching the visual interests of the frame,” 
says Tiffani. “You can use similar framing, similar shapes, or similar motions to cut two clips together.”  

For example, you might use a hand movement in your first clip to transition to the next clip with the same 
hand movement, or if your character or subject is centered in the frame, you could cut to another clip 
with the same or similar framing. Although the two clips are different, they share elements that allow 
you to make a visual match between them. Viewers focus on this element and not the edit, creating the 
illusion that the action in both clips is taking place at the same time.  

6. Use the right transitions — or none at all 
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If you’re transitioning from one clip to the next within the same scene, you probably don’t need to apply 
transitions. To cut from one clip to the next, just stick them together. If your video includes more than 
one scene, you might want to add graphic transitions between them.  

These transitions not only join scenes but can help shape the pace of your video. Stick to crossfades or 
dissolves. “A lot of people use crazy transitions when they don’t really need to,” says Tiff. Elaborate tran-
sitions generally don’t add much to the story and can overpower your montage.  

7. Pay attention to pacing  

Pacing describes the rhythm of a scene which is determined by varying the length of your clips. Some 
scenes, like action sequences, for example, use fast pacing to suggest intensity; others, like interviews 
or dialogue scenes, feel slower, more relaxed, and thoughtful.  

Fast-paced scenes are usually made up of shorter clips, while slow-paced scenes use much longer 
takes, sometimes only a single continuous clip. It can be jarring for your viewers if the pacing of your 
video changes too abruptly or too often. Try to maintain a level of continuity within your scenes. 

8. Choose a color scheme 

If you need to, use color correction tools to give your footage a natural look. Many editing tools also let 
you color grade your footage, i.e. manipulate the color and contrast of your images for creative rather 
than corrective purposes.  

Color grading workflows in Adobe Premiere Pro 

Color grading isn’t necessary, but it can denote mood and character, and 
help you set the tone for your story. Slight adjustments go a long way, 
so don’t overdo it. 

9. Don’t neglect sound 

A high-quality video includes high-quality audio. “People will watch something with poor video 
quality if the audio quality is good, but they won’t watch something with good video quality if 
the audio quality and sound effects are poor,” says Tiff.  

Balance the levels between your audio tracks so that dialogue stands out, and to avoid sudden 
changes in volume. Split edits — like J-cuts, where the sound changes before the image — 
are great for bridging audio between two separate clips or scenes.  

 

10. Add music  

Your soundtrack enhances the feeling of immersion more than any other aspect of your video: design it 
carefully. Don’t let music overpower your soundtrack, and make sure the songs you use are royalty-free 
or that you cleared the copyright if you plan to publish your video publically.  

Silence can add suspense by drawing your viewers’ attention to the screen, but it can also create notice-
able (and sometimes awkward) gaps. Unless the silence is intentional, use room tone to fill in the silence. 
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11. Export to the right format 

“Before you start editing, make sure you’re starting in the right project format,” says Tiffani, including 
choosing the right aspect ratio. Once you’re happy with your edit, export your video. Different editing 
platforms offer different exporting settings, including video format, and other presets, like bitrate, which 
determines the quality level.  

The video format determines how your video file stores audio and video data as well as how that data is 
used for playback. Popular video formats include .webm, .mp4, .flv, .wmv, and .mov, most of which are 
supported by the main online platforms, like YouTube and Vimeo. Be sure the platform you’re uploading 
to supports your export format. 

Choose the best video editing software 

There are countless editing software options, some more complicated than others. Your choice should 
balance usability (or familiarity) with performance. Every platform has a learning curve: the more fea-
tures, the steeper the curve.  

You can work through these questions to help determine which type of software is right for you.  

Is this a big project?  

If you’re putting together a feature-length documentary with hours of raw footage, you’ll need a program 
that can handle it. The same goes for incorporating computer-generated special effects or motion 
graphics.  

Professional-grade software like Adobe Premiere Pro, Adobe After Effects, DaVinci Resolve, or Final Cut 
Pro X include these kinds of advanced features, like video proxies and filters. Many of these tools offer 
great video editing tutorials too, if you’re up for learning something new. 

At the most basic level, look for editing software that allows you to edit the length of clips, turn clips into 
multiple shorter clips, duplicate clips, slow down or speed up clips, increase or decrease the audio of 
clips, as well as add transitions and background music to clips. Most programs include at least these 
functions. 

Is it short and sweet?  

These heavyweights might not be necessary for your pro-
ject. Consider the software you already have; most operating 
systems come with pre-installed video editing software.  

Apple’s Mac, for example, comes with a free video editor 
called iMovie, which is more than enough for most simple 
projects. You can edit YouTube videos, social media clips, and 
other types of video with iMovie.  
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If you’re making a vlog, or an instructional video with some explanatory b-roll, script-based platforms 
like Descript are great for narrative media. Descript helps simplify the editing process by turning your 
video into a transcript that you can edit just like you would text, and includes key features like multitrack, 
keyframe animation, and captions. 

Is my computer powerful enough?  

Consider the editing computer you’re working on, which may not be able to support larger programs. The 
more complex the features, the more computing power you’ll need. Some large editing programs don’t 
work as well on smaller laptops, for example. Make sure your device can handle the job, otherwise you 
risk losing your work to program crashes or other errors. Check the hardware specs required to run 
your program and make sure they align with what you have. 

 

 

 

 

 

 

 

 

 

 

 

Different Types of Video Editing 

There are several different ways to edit video and each method has its pros and cons. Although most 
editors opt for digital non-linear editing for most projects, it makes sense to have an understanding 
of how each method works. 

This page provides a very brief overview of each method — we will cover them in more detail in other 
tutorials. 
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Film Splicing 

Technically this isn't video editing, it's film editing. But it is worth a mention as 
it was the first way to edit moving pictures and conceptually it forms the basis 
of all video editing. 

Traditionally, film is edited by cutting sections of the film and rearranging or 
discarding them. The process is very straightforward and mechanical. In the-
ory a film could be edited with a pair of scissors and some splicing tape, alt-
hough in reality a splicing machine is the only practical solution. A splicing 
machine allows film footage to be lined up and held in place while it is cut or 
spliced together. 

Tape to Tape (Linear) 

Linear editing was the original method of editing electronic video tapes, before editing computers 
became available in the 1990s. Although it is no longer the preferred option, it is still used in some 
situations. 

In linear editing, video is selectively copied from one tape to an-
other. It requires at least two video machines connected together 
— one acts as the source and the other is the recorder. The basic 
procedure is quite simple: 

1. Place the video to be edited in the source machine and a 

blank tape in the recorder. 

2. Press play on the source machine and record on the 

recorder. 

The idea is to record only those parts of the source tape you want 
to keep. In this way desired footage is copied in the correct order from the original tape to a new tape. 
The new tape becomes the edited version. 

This method of editing is called "linear" because it must be done in a linear fashion; that is, starting 
with the first shot and working through to the last shot. If the editor changes their mind or notices a 
mistake, it is almost impossible to go back and re-edit an earlier part of the video. However, with a 
little practice, linear editing is relatively simple and trouble-free. 

Digital/Computer (Non-linear) 

 

In this method, video footage is recorded (captured) onto a computer 
hard drive and then edited using specialized software. Once the ed-
iting is complete, the finished product is recorded back to tape or 
optical disk. 

Non-linear editing has many significant advantages over linear ed-
iting. Most notably, it is a very flexible method which allows you to 
make changes to any part of the video at any time. This is why it's 



Video Editing  10 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

called "non-linear" — because you don't have to edit in a linear fashion. 

One of the most difficult aspects of non-linear digital video is the array of hardware and software 
options available. There are also several common video standards which are incompatible with each 
other, and setting up a robust editing system can be a challenge. 

The effort is worth it. Although non-linear editing is more difficult to learn than linear, once you have 
mastered the basics you will be able to do much more, much faster. 

Live Editing 

In some situations, multiple cameras and other video sources are routed through a central mixing 
console and edited in real time. Live television coverage is an example of live editing. 

Live editing is a fairly specialist topic and won't concern most people. 

What is Video Editing? 

Video editing is the process of manipulating and rear-
ranging video shots to create a new work. Editing is 
usually considered to be one part of the post produc-
tion process — other post-production tasks include ti-
tling, colour correction, sound mixing, etc. 

Many people use the term editing to describe all their post-production work, especially in non-pro-
fessional situations. Whether or not you choose to be picky about terminology is up to you. In this 
tutorial we are reasonably liberal with our terminology and we use the word editing to mean any of 
the following: 

• Rearranging, adding and/or removing sections of video clips and/or audio clips. 

• Applying colour correction, filters and other enhancements. 

• Creating transitions between clips. 

The Goals of Editing 

There are many reasons to edit a video and your editing approach will depend on the desired out-
come. Before you begin you must clearly define your editing goals, which could include any of the 
following: 

Remove unwanted footage 

This is the simplest and most common task in editing. Many videos can be dramatically improved by 
simply getting rid of the flawed or unwanted bits. 

Choose the best footage 

It is common to shoot far more footage than you actually need and choose only the best material for 
the final edit. Often you will shoot several versions (takes) of a shot and choose the best one when 
editing. 

Create a flow 
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Most videos serve a purpose such as telling a story or providing information. Editing is a crucial 
step in making sure the video flows in a way which achieves this goal. 

Add effects, graphics, music, etc 

This is often the "wow" part of editing. You can improve most videos (and have a lot of fun) by adding 
extra elements. 

Alter the style, pace or mood of the video 

A good editor will be able to create subtle mood prompts in a video. Techniques such as mood music 
and visual effects can influence how the audience will react. 

Give the video a particular "angle" 

Video can be tailored to support a particular viewpoint, impart a message or serve an agenda. 

 

NTSC vs. PAL | Definition, Format & Facts 

NTSC is an abbreviation for National Television Standards Committee, named for the group that 
originally developed the black & white and subsequently color television system that is used in the 
United States, Japan and many other countries. An NTSC picture is made up of 525 interlaced lines 
and is displayed at a rate of 29.97 frames per second. 
PAL is an abbreviation for Phase Alternate Line. This is the video format standard used in many Eu-
ropean countries. A PAL picture is made up of 625 interlaced lines and is displayed at a rate of 25 
frames per second. 
SECAM is an abbreviation for Sequential Color and Memory. This video format is used in many East-
ern countries such as the USSR, China, Pakistan, France, and a few others. Like PAL, a SECAM pic-
ture is also made up of 625 interlaced lines and is displayed at a rate of 25 frames per second. How-
ever, the way SECAM processes the color information, it is not compatible with the PAL video format 
standard. 

Adobe Premiere Pro CC 2021 Overview 

Adobe Premiere Pro CC 2020 is a powerful and professional video editing software that 

allows producers and filmmakers to easily edit their footage without losing quality. This 

is a comprehensive application that provides you with advanced tools, functions, and mod-

ules. The program utilizes GPU-accelerated Adobe Mercury Playback Engine that delivers 

high-quality performance for video production and enables you to work dramatically 

faster.It supports all types of video formats, camera, quality, and platform. You can also 

download Siemens Star CCM + 2020 Free Download. 

The program comes fully integrated with other Adobe products for more detailed productions. It offers users to improve 

sound quality and add a precise and simple color grading. It has got some new features such as Faster face masking, 

Ruler and Guides, Freeform View, and much more. It offers high processing functions with greater accuracy and smooth-

ness. With this tool, users can create visuals for web formats too and it also supports other exporting formats with high-

quality output. Additionally, it has the ability to create Blu-ray and DVD movies with custom menu. You can also down-

load XAMPP 2020 Free Download. 
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Features of Adobe Premiere Pro CC 2021 

Below are some noticeable features which you will experience after Adobe Premiere Pro CC 2021 Free Download 

• Professional video editing software that allows producers and filmmakers to easily edit their footage without 

losing quality. 

• Comprehensive application that provides you with advanced tools, functions, and modules. 

• Utilizes GPU-accelerated Adobe Mercury Playback Engine that delivers high-quality performance for video 

production. 

• Enables you to work dramatically faster. 

• Supports all types of video formats, camera, quality, and platform. 

• Fully integrated with other Adobe products for more detailed productions. 

• Offers users to improve sound quality and add a precise and simple colour grading. 

• Has got some new features such as Faster face masking, Ruler and Guides, Freeform View, and much more. 

• Offers high processing functions with greater accuracy and smoothness. 

• Enables the users to create visuals for web formats too. 

• Supports other exporting formats with high-quality output. 

• Ability to create Blu-ray and DVD movies with custom menu. 

 

Adobe Premiere Pro CC 2021 Technical Setup Details 

Prior to start Adobe Premiere Pro CC 2021 Free Download, ensure the availability of the below listed system specifications 

• Software Full Name: Adobe Premiere Pro CC 2021 

• Setup File Name: Adobe_Premiere_Pro_2021_v15.4.0.47×64.rar 

• Setup Size: 1.7 GB 

• Setup Type: Offline Installer / Full Standalone Setup 

• Compatibility Mechanical: 64 Bit (x64) 

• Latest Version Release Added On: 03th Aug 2021 

• Developers: Adobe 

 

System Requirements for Adobe Premiere Pro CC 2021 

• Operating System: Windows XP/Vista/7/8/8.1/10 

• RAM: 8 GB 

• Hard Disk: 2 GB 

• Processor: Intel Dual Core or higher processor 

• Display: 1280 x 800. 

Install Adobe Premiere Pro 

Step 1: First of all, go to adobe.com and the official website of the adobe system. 

Step 2: For our product, go to the All Product option button, which is present at the top of this web 

screen and click on it. 

Step 3: A new web screen will open, scroll down or search Adobe Premiere Pro software in the search 

box.Or you can click on the Free trial option button, which is present at the top of this web screen; 

click on it. 
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Step 4: New web screen will open; search Adobe Premiere Pro software here by scrolling down. 

Or if you want to buy any product, you can directly go to the Choose a Plan option here, which is present 

at the top of this web screen, and click on it. 

Step 5: Different plan packages will open in the new web screen, choose your product name in the 

Single App drop-down option. 

Step 6: Now, these are the methods for finding adobe premiere pro software on the official website of 

adobe systems; I will go with the free trial option for downloading my adobe premiere pro software 

from here. 

OR here, you can choose the Download trial option for downloading the trial version of adobe premiere 

pro software or click on Buy for buying the software. 

Step 7: I will click on the Download trial option, a new web screen will open, it will ask your skills 

about adobe Premiere Pro software, whether it is Beginner, Intermediate, or Advance level. Choose 

the level according to your skill level of adobe Premiere Pro. 

 

Step 8: Now it will ask you a question ‘Open Creative Cloud desktop App?’ for the opening creative 

cloud app on your desktop to install adobe premiere pro software on your pc. 

Step 9: Click on the ‘Open Creative Cloud desktop App’ button to open the app; once it is open, you will 

find all apps of the adobe system available there; downloading of adobe premiere pro software will 

automatically start on your pc, you can see downloading in this section. 

Step 10: Downloading the speed of the software will depend on the speed of your internet. At the top 

of this box, you can see how much percentage of your software is downloaded. 

Step 11: It will take some time for downloading adobe premiere pro software; after the completion of 

downloading the software, it will automatically be installed on your PC or laptop. This is the user 

interface of the adobe premiere pro software; now, you can start practicing on it. 

Creating a New Project   

1. Open Premiere Pro and you’ll be greeted with the 

home screen.  

2. Select New Project. When the New Project window 

opens, give your project a name, a location (for ex-

ample, the folder you created for your project file). 

Then click the tab titled Scratch Disks to make sure 

everything is going to be saved to Same as Project.  

3. Finally, click OK. Your new project will open.  
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The User Interface Of Adobe Premiere Pro 

  

There are several windows with different names that can be seen at the top left of each one.  

1. The Project window is where all of your files and folders are located. In video editing ter-

minology, folders are called bins. This window is where you can organise your rushes and 

open individual clips.  

2. The Source window will display a visual representation of whatever is selected in the pro-

ject window. You’ll be able to view your rushes in this window and select the whole or part 

of a clip to use in the timeline.  

3. In the Timeline window is where you will edit your film using video and audio tracks.  

4. The Program window contains the visuals of your edited sequence. Here you can watch 

what you have edited so far.  

5. You have the ability to change your workspace by dragging and dropping the windows into 

a different order. If you want to reset your workspace, you can do so by selecting: window 

> workspaces > reset to saved layout.  

 Tools Adobe Premiere Pro  

To the left of the timeline window, you’ll see some icons in a small thin window. These are 

the tools. Using these different tools allows you to go into different modes of working in 

Premiere.  

1. Selection Tool (V): You can select clips, move clips around on the timeline, trim clips, 

select menu items and buttons, as well as select many other items within the user 

interface.  
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2. Track Select Forward Tool (A): With this selected, when you click on the timeline, every 

clip on all tracks from the cursor and to the right will be selected. When you hold shift, 

every clip from one track from the cursor and to the right will be selected.  

3. Ripple Edit Tool (B) Drag the edge of a clip to ripple-trim the selection.  You will see how 

the clip that will be trimmed is the one you have selected, other clips will not be affected, 

but will also not leave a gap.  

4. Rolling Edit Tool (N): Drag the edge of a clip to trim incoming and outgoing clips simulta-

neously. Using this tool will leave a gap if you only trim one clip at a time.  

5. Rate Stretch Tool (R): Drag the edge of a clip to rate stretch the selection, this will change 

its speed to match the new duration.  

6. Razor Tool (C): Click to split a clip into two. Using Alt will override a link in the clips and 

using Shift will create a split over all tracks.  

7. Slip Tool (Y): Drag on a clip to slip the selection, this will modify the media in and out 

points without changing its position in time.  

8. Slide Tool (U): Drag on a clip to slide the selection, this will modify its position in time by 

trimming the adjacent clips.  

9. Pen Tool (P): Used to create, select and move keyframes, for example when making ad-

justments in the audio.  

10. Rectangle Tool: This tool can be used to create a rectangle shape in the program window.  

11. Ellipse Tool: This tool can be used to create an ellipse shape in the program window.  

12. Hand Tool (H): This tool can be used to scroll horizontally in time by dragging.  

13. Zoom Tool (Z): Click to zoom in one level in time and use Alt to zoom out one level in time.  

14. Type Tool (T): Click in the program window and type to create text.  

15. Vertical Type Tool: Click in the program window and type to create vertical text. 

Importing Media to Project Explorer Using Media Browser 

  

At this point, you should have transferred your rushes/footage to a folder, or you might want to 

bring something else into your project such as a title sequence, a photo, or a piece of music.  
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This process is known as importing.  

There are many ways to import items into Premiere. However, there is a specific method you can 

use that can stop certain issues from occurring.  

To import using this method, go to Media Browser, which is located on the second tab in the pro-

ject window. Locate your files, select them, right click and select import.  

Your files should now appear in the project window.  

 Organizing in the Project Window  

  

It’s good to review your rushes in Premiere then sort the clips and everything else in your pro-

ject into some sort of organizational system that makes sense to you.  

It might seem time consuming to rename clips and place them into bins; however, this process 

can save you a lot of time later on in your project. It’s useful to keep to an organizational system 

inside the project window in order to save time and prevent confusion.  

You can rename a clip by right clicking on it in the project window and clicking rename.  

You can create a bin by right clicking anywhere in the project window and clicking New Bin.  

Drag and drop a file into a bin to start organizing your project files into bins. 

 

 

 

 

 

 



Video Editing  17 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

Creating a New Sequence  

  

A sequence is where you can edit a film or video using video and audio tracks. You can work on 

a sequence in the timeline window.  

1. You can create a sequence by right clicking anywhere in the project window, clicking new 

item and then Sequence...  

2. The New Sequence window will open, and from here you can choose the settings you 

want your new sequence to have.  

3. It’s important that the sequence settings are correct. If you’re editing with video rushes, 

you’ll most likely want to make sure that the sequence settings match the rushes settings. 

If you don’t the film could end up looking very different from what you wanted.  

4. If you’re new to these settings, there’s a simple technique you can use to make sure your 

video rushes and sequence settings match.  

5. Simply click OK on the New Sequence window, regardless of what settings it has been 

created with.  

6. The sequence will arrive in both your project window and timeline window.  

7. If your sequence ever goes missing from the timeline, you can double click it in the pro-

ject window to open it back up again.  
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8. Drag and drop a video clip anywhere into your sequence and if the settings don’t match, 

you’ll see another window.  

  

If you want your clip and sequence settings to match, select Change sequence settings.  

The sequence will change to the same settings as your original clip, making sure your film will 

look the same as your original footage.  

Starting the Video Editing Process 

As previously mentioned, Premiere is a very intuitive software. There are often many ways to do 

the same thing.  

1. If you double click on a clip in the project window, the content will appear in the source 

window, whether this is the first frame of a video clip, the visuals of a photo or the wave-

forms of an audio clip.  

2. You’ll find that you can drag a clip into the timeline and you’ll then see one or a number of 

bars have appeared on your timeline and sequence.  

3. This is your clip, visually represented as a rectangular bar (or bars) on the timeline.  

4. You can move these by dragging them left or right, so that the clip will play at a different 

point in time.  

5. If you see two bars, one on V1 and one on A1, this means that your video clip is made up of 

both Video and Audio. V1 and A1 are video tracks and audio tracks. You’ll notice that there 

are three video tracks and three audio tracks. These can be used for when you start plac-

ing more clips and media onto your timeline.  

6. The video tracks are layered on top of each other. V3 is on the top, so a clip that is on this 

track will be seen above whatever is on V2 and V1. V2 is underneath V3 and above V1. This 

layering can be useful for a number of reasons, but for now just know that if you are una-

ble to see one of your video clips in the program window, it might be because there is an-

other clip on a track above.  

7. There are multiple audio tracks to give you the ability to layer many different sounds in 

your film. For instance, you might want the original audio from your rushes on A1, some 
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music on A2, and some extra sound effects on A3. If you place all these on each track at 

the same point in time, they will play all at the same time.  

8. Press the play button on the program window to watch your edit. As you do so you will 

notice the blue line in the timeline window (the play head) will start to move from left to 

right, you will also see the visuals of your edited sequence in the program window, and 

hear the audio of your sequence.  

An Introduction to Basic Editing (Selection and Cutting Clips) 

Some ways of using the software are more efficient than others. In this section, you’ll learn more 

about these powerful and more effective ways of editing a film.  

1. It’s true that you can drag and drop a clip straight from the project window to the timeline 

window. You can cut this clip down, using the cursor, at either end of the clip to trim and 

you can use the razor tool to cut clips and delete the parts you don’t need.  

2. However, editing your clips within the timeline itself can be difficult, especially if you have 

already built up a lengthy sequence within the timeline.  

3. There’s nothing wrong with editing a film in this way, but there are many more methods of 

editing a film within Premiere.  

4. Let’s say you wanted to include part of a clip into your sequence. One method is that you 

could drag the whole clip in and trim or cut it in the timeline. But there is also a way you 

can select part of the clip and only bring in what is needed before it reaches the timeline.  

5. Double click on the clip in the project window. It will show in the source window. On the 

source window there are a few tools you can use. You can press the play button (space) to 

watch the clip. Press the stop button (space) to stop watching.  

6. There are also two shortcuts that aren’t on the source or program windows as buttons 

but are very helpful: rewind (J) and fast-forward (L). You can use these while the source 

window is selected to scrub through the clip. The more times you press either shortcut, 

the faster it will rewind or fast-forward.  

7. There might be a lot of footage at the beginning that isn’t needed, so locate the first frame 

of the clip that you would like to include in the edit. When you have found it, locate and 

press the tool on the source window called mark in (I). You will notice that everything 

from this point onwards will become highlighted.  

8. Find where you want the section of your clip to end, which might be before the clip itself 

ends. Once you have found the exact frame, press the button named mark out (O).  

9. You’ll notice now that you have selected a part of the clip between the in and out points 

you have made.  

10. If you were to drag and drop this into your timeline, it would only bring in the part in be-

tween the in and out points, meaning that you don’t have to do any editing of the clip inside 

the timeline itself.  

11. You can go one step further and completely skip the drag and drop method by using the 

insert (,) and overwrite (.) buttons. I’ll be going into more detail about insert and overwrite 

in later sections.  
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Tracks on the Timeline  

Before moving on to using the insert and overwrite buttons as powerful tools to use for editing, 

we should take a brief look at the left section of the timeline window where information on the 

tracks is located.  

  

There are two sets of tracks next to each other.  

The ones on the left, might show two tracks, V1 and A1. These are the tracks that belong to the 

source. For example, if you click on a clip in the project window, and it appears in the source 

window, you’ll also find that the tracks for this clip appear.  

Next to these, just to the right of the source tracks, you'll find the tracks for the sequence. When 

creating a new sequence, by default, three video tracks and three audio tracks are created. This 

is what V1, V2, V3, A1, A2 and A3 are.  

You can create more tracks for the sequence by clicking anywhere in the empty space around 

the tracks and selecting add tracks.  

This information on tracks is important to know for the insert and overwrite method of bringing 

clips into your sequence, which we will be looking into in the next two sections.  
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 Insert Clips on Timeline 

Let’s say you have a sequence with at least two video clips.  

  

Let’s also say that you wanted to insert a third clip in between two clips.  

Using a method of moving every other clip out of the way, dragging and dropping the clip into the 

timeline, and then bringing everything back together again might be one way to do this, but it re-

quires many steps to do so.  

What might be easier is using the insert (,) button on the source window. First put the play head 

(the blue line on the timeline window) where you want the clip to go. (Holding shift while moving 

the play head will snap it to the beginning and end of clips.)  

With the third clip selected and visible in the source window, press the insert (,) button.  

  

The new clip will be inserted in between the two clips on tracks V1 and A1. Nothing will be de-

stroyed because of the inclusion of the new clip. Instead, everything after the clip after will be 

pushed further along the timeline to make room for the new clip.  

This is a simple method of inserting a clip into your sequence.  
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Overwrite Clips on Timeline 

Let’s say that you wanted to use V2 to place a clip. You can do this by using the overwrite tool.  

  

First make sure the play head is placed where you would like the new clip to begin.  

Select the new clip in the source window. Then make sure V1 of the source is aligned to V2 of the 

sequence in the section left of the of the timeline window. If there is audio on the clip, make sure 

A1 of the source is aligned to A2 of the sequence. You can do this by dragging and dropping with 

your cursor.  

Click the overwrite (.) button.  

  

The new clip will be added to the sequence on V2 and A2 and no other clips will move. 

Exporting The Final Video After Editing 

Once you have completed your edit and are ready export, creating a file of your film or video, 

you’ll need to go through the exporting process.  

When you have finished your edit, click on the timeline window to make sure it is selected. Go 

to: file >export > media  

You will see the export settings window.  
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There are many options for you to choose from and it entirely depends on what you are doing as 

to what settings you should choose. However, if you have edited your footage with Full HD 

rushes and your sequence settings are 1080p and 25FPS, the following settings might be useful 

for you to know.  

The next section will show you how to make an MP4 file. The MP4 container is a widely used one 

within the industry and is usually able to play and be viewed on many devices.  

Export Settings  

First of all, make sure Source Range is set to what you need it to be. If you want to export your 

entire sequence, make sure this is the setting you choose.  

Below are the settings I would recommend to produce a 1080p 25FPS MP4 file:  

Format: H.264  

Output Name: Make sure you give your film a name and place it in your exports folder or a place 

where you will be able to find it.  

Export Video and Export Audio: Both need to be checked.  

In the Video Tab:  

Width: 1920  

Height: 1080  

Sardar Azeem 
Professional Graphic Artist and Video Editor 
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Frame Rate: 25  

Field Order: Progressive  

Aspect: Square Pixels  

Render at Maximum Depth: Checked  

Bitrate Encoding: VBR, 2 pass  

Target Bit Rate and Maximum Bit Rate: At least 16 (be careful that you don’t put the bit rate too 

high, for example, the target bit rate for the preset named High Quality 1080p HD is 20)  

Use Maximum Render Quality: Checked  

Then press export. There will be a progress bar and your film will take some time to export. The 

result will be an MP4 file of your final film in the folder you selected.  

USING THE PROJECT PANEL 

As mentioned previously, the Project panel contains references to all the foot-
age files (video, audio, and images) that you have imported into Premiere Pro. 
As such, it is the creative hub for all you will create with this application. In ad-
dition to references to your imported footage, the panel holds the Sequences 
and Titles that you can create within the application, and is where you locate the 
items you want to add to the Timeline. 

Understanding media management 

Media Management is the organization or management of the media you work 
with in a project. There are two equally important aspects to Media Manage-
ment. The first is how you manage the media on your hard drives, and the sec-
ond is how you organize the different media references that you import into 
Premiere Pro. 

To ensure portability, performance, and security, many users highly recommend 
that you store media on an external hard disk drive. The two standard connec-
tion types for external hard drives are FireWire (400 and 800) and USB 2.0. Most 
video editors recommend a FireWire drive because of its higher sustained bus 
speed, but any type of drive works for your projects. Newer technologies, such 
as thunderbolt and USB 3.0, also provide excellent connections for media stor-
age drives. Depending on your system configuration, these connection types 
may not be available to you at this time. 

The files that you will work with to complete the lessons in this book are orga-
nized into a single folder called Media Library. Within that folder, there are 
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additional folders for each individual project. In each respective project folder, 
there are folders that separate the different types of media (video, audio, and 
still images) you will use. This type of hierarchical structure is also used to keep 
the project panel organized and makes it easier to locate the media you want to 
add to the Timeline panel. 

Before you can edit any piece of footage on the Timeline, you must first add it to 
your Premiere Pro project. You can import a wide variety of media, including 
video, audio, still images, After Effects Projects, and other Premiere Pro pro-
jects. 

In this section, you will import a variety of media files into your project that you 
can later organize and add to your Timeline. 

1 With the pr0201-working file still open, confirm that you are using the Digital 
Classroom-Editing workspace that you created earlier in this lesson. If you have 
made any changes to the workspace, you should reset it now. If the Project 
panel is hidden behind the Program Monitor, click on the Project panel tab now 
to bring it forward and make it active. 

2 Choose File > Import to open the Import dialog box, then navigate to the Media 
Library folder located inside the prlessons folder that you copied to your hard 
drive. 

Select the Travelogue-Boston folder, and then select the Video subfolder to re-
veal the video files you will import for this lesson. 

3 Inside the Video folder, there are six video files shot in the city of Boston: Bos-
ton-Bridge Pan.mov, Boston-Building Tilt Up.mov, Boston-City Pan.mov, Boston-
Marina Pan.mov, Boston-Paul Revere Park.mov, and Boston-TD Garden.mov 

Click the first video file in the dialog box, hold the Shift key on your keyboard, 
and then click the last file to select every file between them. 

Click the Import button to import all the selected files into your project panel. 
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All recently imported files are automatically selected/highlighted in the project 
panel. 
4 In addition to importing individual or groups of files, you can import entire 
folders and their content. 

Choose File > Import and navigate to the Travelogue-Boston folder in the Media 
Library. In the Import dialog box, click once on the Audio folder to select it, and 
click the Import button. 

 

 

Importing entire folders is a quick way of importing multiple files, along with 
their content and subfolders. 
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When you import a folder into Premiere Pro, the application automatically cre-
ates a bin in the Project panel with the same name as the imported folder. The 
content of the folder on your hard drives, as well as the content of any sub-fold-
ers, is placed inside this bin. 

In NLE (Non-Linear Editing) parlance, a bin is basically just the name for a file 
folder. The functionality of bins in the Premiere Pro Project panel is almost 
identical to those of the file folders on your computer. 

5 Click the reveal triangle to the left of the Audio bin to show the clips that you 
imported. 

 

Each bin’s reveal triangle can show and hide the bin’s contents. 

6 Choose File > Save or press Ctrl+S (Windows) or Command+S (Mac OS) to 
save the project file. 

In the next part of the lesson, you will create a new bin to hold the video files 
you just imported and keep the project panel organized. 

Creating and organizing bins 
The term bins comes from the days of editing film when the developed film clips 
were stored in bins for easy organization. In the Premiere Pro project panel, 
bins serve as file folders to hold and organize your media assets. Bins can hold 
any combination of media: video, audio, still images, and even other bins. The or-
ganizational scheme you use for this exercise will create a separate bin for 
each different type of media used in the project. 
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The media management strategy that you adopt depends on the specifics of the 
project and the quantity of footage. For larger projects, you might break the 
footage into bins based on the content of the video, location, or for dramatic 
works, the footage needed for a specific scene (scene-based organizational 
system). 

1 If the Audio bin is still selected, click on any empty area of the Project panel to 
deselect it. Then create a new bin by clicking the New Bin button located at the 
bottom-right of the Project panel. Rename this bin video and press Enter (Win-
dows) or Return (Mac OS) to confirm the new bin name. 

When you create a new bin, it will automatically be placed inside the bin that you 
currently have selected. This is why it is important to remember to deselect the 
Audio bin in this step. 

 

The term bin is a legacy from the days of film editing. In practice, bins function 
exactly like the folders on your hard drive. 
2 Click the first video clip displayed in the Project panel, hold the Shift key on 
your keyboard, and click the last video clip to select every clip between them. 



Video Editing  29 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

 

Holding the Shift key allows you to select files in sequential order. 
3 Release the Shift key and then click any one of the selected files and drag it to 
the Video bin. When the bin’s folder icon becomes highlighted, release the 
mouse to move all the selected files into the bin. 

 

Moving and arranging media items in the Project panel is similar to moving and 
arranging files on your hard drive. 
4 Click any empty area of the Project panel to deselect the Video bin, and then 
click the New Bin button again to create a third bin. Rename this bin Boston 
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Footage and again press the Enter (Windows) or Return (Mac OS) to confirm the 
new bin name. 

5 Click the Audio bin, then press and hold the Control (Windows) or Command 
(Mac OS), and click the Video bin to select both. 

6 Release the Control (Windows) or Command (Mac OS) key and then drag ei-
ther of the selected bins into the Boston Footage bin. This moves both the se-
lected bins inside the bin named Boston Footage. 

 

Storing bins inside one another is an efficient organizational tool and can pre-
vent the Project panel from becoming cluttered. 
7 Choose File > Save or press Ctrl+S (Windows) or Command+S (Mac OS) to 
save the project file. 

Now that you have organized the Project panel, in the next part of the lesson 
you will modify the panels display so that it is easier to view the most relevant 
information about your media items. 

Modifying the Project panel display 
The Project panel displays information about each item it contains in a series of 
columns to the right of each item’s name. This information display can be cus-
tomized so that you can control which properties display and in what order. This 
allows you to view only the attributes that are most relevant to the type of work 
you are currently doing at any given time in Premiere Pro. 
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Adding/removing columns in the Project panel 
The default column display can be changed, to add hidden panels or remove 
panels that you may consider extraneous. 

1 Since the Project panel is very small when compared with the overall Premi-
ere Pro interface, seeing all the columns at the same time is impossible. The 
first thing you will do is expand the panel to full-screen size. Note that even in 
full-screen mode you may not be able to view every data column in the Project 
panel depending on your monitor’s resolution. 

Click on any area of the Project panel to select it. You will know it is selected 
when it has an orange border around it. 

With the Project panel selected press the tilde (~) key on your keyboard. 

 

The tilde (~) key acts as a minimize/maximize toggle for whichever panel is cur-
rently active. 
2 The expanded Project panel makes it much easier to see each clip’s proper-
ties. 

Click on the menu button located at the upper-right corner of the Project panel 
and from the menu that appears, choose Metadata Display. Metadata is infor-
mation that is attached to files that contains extra information about the file. For 
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a video clip, metadata could include information such as the length, audio infor-
mation, or frame size and rate. 

 

Even though the clip properties are only used inside Premiere Pro they are still 
listed as a part of the overall metadata properties. 
3 In the Metadata Display panel click on the reveal triangle to the left of Premi-
ere Pro Project Metadata to reveal its properties. 

Click and drag the lower-right corner of the dialog box to enlarge it so that you 
can see all the revealed attributes. Each attribute corresponds to one of the vis-
ible columns in the Project panel. 
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Some clip properties are turned off by default in the Project panel display. 
4 In the dialog box, disable the following attributes by clicking to clear the check 
mark to the left of the attributes. 

Frame Rate Media Start Media 
End 

Media Du-
ration 

Video Info 

Audio Info Tape Name Log Note Capture 
Settings 

Status 

Scene Good       
You do not need these attributes for the work you will do in this project. The Me-
dia (displayed in Timecode) and Tape Name properties refer to the tape that 
these clips were captured from. The Frame Rate, Video, and Audio Info and Cap-
ture settings are the same for all the clips you will work with in this project. You 
will not use the other properties, such as Scene, because they are intended for 
a different type of project workflow than you will be working with here. 
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Understanding timecode 
 

Timecode is used in video editing and motion graphics programs to keep track 
of your position along a Timeline, tape, or any time-based medium. You can 
identify timecode as a series of four numbers separated by colons or semico-
lons. As seen in the example above and reading from left to right, the numbers 
represent: Hours;Minutes;Seconds;Frames. 
You can count hours, minutes, and seconds in much the same way as you would 
with a standard clock, but the counting begins at zero instead of one. The one 
variable with timecode is the number of frames that make up a second, which is 
based on the frame rate of the media you are dealing with. Depending on the 
Composition settings, you could be using the American television standard of 30 
FPS (frames per second), the European standard of 25 FPS, or the film standard 
of 24 FPS. In essence, timecode provides a discrete address to each frame of 
video. 

5 Click the OK button. The Project panel was reduced to a few columns. 
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The visible columns in the Project panel can be adjusted at any time depending 
on the needs of your project. 
6 Choose File > Save or press Ctrl+S (Windows) or Command+S (Mac OS) to 
save the project file. 

Do not close this file; you will need it in the next exercise. 

In the next section, you will edit the clip descriptions and change the order that 
the columns display in. 

Adding a clip description 
Some of the columns in the Project panel are purely descriptive; they display in-
formation about the properties of the footage you are working with. Columns 
such as Media Start, Media End, and Media Duration are non-editable, while oth-
ers, such as Video In Point, Video Out Point, and Video Duration, can be changed 
as you work with your clips in Premiere Pro. Columns such as Description can 
be edited directly in the Project panel itself. Clip descriptions can be very help-
ful, especially when working on longer, more complex projects, or when work-
ing in a team environment. The Description column of the Project panel contains 
an editable text field that can be used to hold a wide variety of information, such 
as a content description, or to note intended usage. 

1 With the Project panel still expanded to the full size of the screen and active, 
click the Description column header and drag it to the left. As you drag the col-
umn name, a dark highlight appears between each pair of names. 

Drag the Description column until this highlight is between the Label and Video 
In Point columns, and then release it to rearrange the column order. 
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You can drag any column title to the left or right to change the arrangement of 
the Project panel’s columns. 
2 You have repositioned the Description column, but there is not enough room in 
the column to read all the text currently present. 

Place your cursor on the dividing line between the Description and Label col-
umn headers. When the cursor changes to a double-headed arrow, click and 
drag to the right to change the width of the Description column and move all the 
other columns over. 

After enlarging the Description column, repeat these steps for the Name column 
so you can see the full name of each audio and video file. Depending on the 
screen resolution of your monitor, enlarging the Name field may not be neces-
sary. 

 



Video Editing  37 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

 

You can quickly edit visually the width of each column directly from the Project 
panel interface. 
3 Locate the clip named Boston-TD Garden.mov. You can edit a clip’s Description 
property any time. 

Click in the clip’s description field and replace the current generic description 
with the following text: Pan from left to right past the sports arena. Press the 
Enter (Windows) or Return (Mac OS) key on your keyboard to deselect this clip’s 
text field and automatically select the next clip’s description. 

4 Press the tilde (~) key on your keyboard to return the Project panel to its nor-
mal screen size. 

5 Choose File > Save or press Ctrl+S (Windows) or Command+S (Mac OS) to 
save the project file. 

In your own projects, you should consider giving each clip in the project panel a 
unique description. This can include any information you feel is important to 
your editing process, such as time of day, the subject of the shot, or notes on 
camera position or movement. 

Organizing content by columns 
The columns of the project panel are used to control how the different items in 
the panel display. You can arrange your clips based on the content of any col-
umn. 
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1 In the Project panel, the default organization is alphabetically based on the 
name. In the case of bins, the bin name is used to arrange all the media it con-
tains. The active panel shows either a downward or upward pointing chevron 
next to the column header. 

2 Click the Column Name to reverse the standard ascending display order and 
notice how items reverse their display order in the panel and are now displayed 
in descending order. When working on your own projects, you can choose the 
order you prefer. For this project, we will place the Travelogue-Boston Se-
quence at the top of the display. 

 

 

The footage display in the Project panel can be based on any currently displayed 
column. Simply click on any column heading to reorder the footage in the panel. 
3 Choose File > Save or press Ctrl+S (Windows) or Command+S (Mac OS) to 
save the project file. 

Choose File > Close Project to close this project and return to the Premiere Pro 
welcome screen. 
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What is the use of Adobe Premiere source monitor? 

The main purpose of the source monitor in Adobe Premiere allows you to view your clips at full res-

olution and to set in and out points. Its description simplifies the source monitor and makes its pur-

pose seem minimal. In this you can set in and out points in the project panel. But there is really a lot 

to it. 

We are going to talk about it:- 
• View clips inside source monitor. 

• Helping to configure the source monitor. 

• Working with source monitor in clips. 

Introduction Details of Source Monitor 

The Source Monitor project offers different views comparing the two in the panel. 

Go to the panel menu to find ideas. The panel menu source is present in the upper right hand corner 

of the monitor panel. 
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How to configure source monitor. 

Learning the playback controls in the source monitor will save you a lot of time when editing clips 

for your project. You can mouseover any control to find the name of the control. It is hoped that their 

purpose is already familiar. 

Source Monitor, along with all playback controls, also includes several configuration options that 

can be used to customize the source monitor to fit your needs. You may find it helpful to access 

most settings by clicking the panel menu or clicking a little wrench to get the source monitor. 

Basic Premiere Pro Keyboard Shortcuts 

 

Command Short Cut Key 

Save Ctrl + S 

Save A Copy Ctrl + Alt + S 

Import Ctrl + I 

Export Ctrl + M 

Open Project Ctrl + O 

New Project Ctrl + Alt + N 

New Sequence Ctrl + N 

At some point in every edit, undo and redo will become your favorite Premiere Pro keyboard 

shortcuts! 

Command Short Cut Key 

Cut Ctrl + X 

Copy Ctrl + C 
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Command Short Cut Key 

Paste Ctrl + V 

Undo Ctrl + Z 

Redo Ctrl + Shift + Z 

Clear Delete 

Ripple Delete Shift + Delete 

Duplicate Ctrl + Shift + / 

Select All Ctrl + A 

Deselect All Ctrl + Shift + A 

 

Tool Shortcuts 

Now, when it comes to editing the actual footage on your timeline, there are a lot of tools at your 

disposal. Using these really speeds up the process. 

 

Command Short Cut Key 

Selection V 

Razor C 

Ripple Trim Previous Q 

Ripple Trim Next W 

Track Select Forward A 

Track Select backward Shift + A 
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Command Short Cut Key 

Ripple Edit B 

Rolling Edit N 

Rate Stretch R 

Slip Tool Y 

Slide Tool U 

Pen Tool P 

Hand Tool H 

Zoom Tool Z 

 

Navigation Shortcuts 

Lastly, one of the most time-consuming elements of any edit is simply navigating around the soft-

ware with your cursor. Spending a few seconds dragging your mouse from left to right may not 

seem like a big deal. 

However, when you add up these valuable seconds over the course of many days, it can become a 

real pain. 

Command PC 

Toggle Play/Stop Space 

Find In Source F 

Shuttle Left J 

Shuttle Right L 

Stop K 
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Command PC 

Turn Snap On/Off S 

Mark In Point I 

Mark Out Point O 

Go To In Point Shift + I 

Go To Out Point Shift + O 

Clear In & Out Ctrl + Shift + X 

Step Back Left Arrow 

Step Forward Right Arrow 

Next Edit Point Down Arrow 

Previous Edit Point Up Arrow 

Move Footage Alt + Arrow 

 

In short, there’s a lot you can do on Premiere Pro just by using the keyboard shortcuts. It’s possible 

to edit a whole project without ever using your cursor! 

Effects control window Adobe Premiere Pro 

You can use effects to correct color and brightness; however, they can also be used to add anima-

tion, produce overlays, and create greenscreen effects. 

we will learn about: 

• The Effects Workspace 

• Applying effects to clips 

• Animating effects with keyframes 

• Copying and pasting effects 
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• Creating effect presets 

• Keying and compositing 

• The Garbage Matte 

The Effects Workspace 

When you want to edit effects, you go to the Effects workspace, which is made up of the Effect Con-

trols panel, the Program Monitor, and the Effects panel. 

To reach the Effects panel, go to Window> >Effects.  

You can see the Effects panel in the snapshot below. 

 

The Effects panel is where you find all effects. The Effect Controls panel is where you will configure 

the effects. Finally, the Program Monitor is where you can preview the effects that you add. 

Adding an Effect to a Clip 

To add an effect to a clip, drag the effect from the Effects panel onto the clip on the Timeline. 

As an example, we are going to drag the Edge Feather effect to our clip. 

 

You can also select a clip in the Timeline, then double click on the effect in the Effects panel. 

Customizing an Effect 

Once you have added an effect to a clip, you can go to the Effect Controls panel to customize it. 
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We added the Twirl In effect to a clip.  

 

By going to the Effect Controls panel, we can adjust the effect by changing the values and parame-

ters. 

You can also toggle the effect on and off to see the impact of the effect on your clip. 

Toggle an Effect On or Off 

To toggle an effect off, click the fx icon that appears to the left of the effect name.  

When you do this, the effect is disabled. 

To turn the effect back on, click the fx icon again. 

Changing the Order of Effects 

The order that effects will appear on your clip is shown in the Effect Controls panel. 

To change the order of effects on the clip, drag an effect up or down in the Effect Controls panel. 

You will see a horizontal bar to let you know where the effect will be placed when you release the 

mouse. 

Just remember that you cannot drag standard effects above fixed effects.   You also cannot drag 

fixed effects below standard effects. 

Removing an Effect 

To remove an effect in the Effect Controls panel, select the effect. 

Next, either press the Backspace or Delete key on your keyboard. 

You can also right click on an effect, then choose Clear. 

To remove an effect in the Timeline, select the clip or clips, then right click on the clip and select Re-

move Effects. 
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You will then see the Remove Effects dialogue box. 

 

Check the effects that you want to remove.  

NOTE : Intrinsic effects are fixed effects. 

Click OK to remove the effects. 

Animating Effects with Keyframes 

Now we are going to use keyframes to animate effects that we have applied to clips in the Timeline.  

Adding Motion to Effects 

To add motion to effects using keyframes, start out by adding the ProcAmp effect to a clip in the 

Timeline. 

Next, move the playhead in the Timeline to the start of the clip. 

Go to the Effect Controls panel. Click the triangle to the left of the effect to see the configuration op-

tions, as pictured below. 

 

Click the Toggle Animation button to the left of the effect that you want to configure so that 

keyframes are enabled. 
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Interested in learning more? Why not take an online Adobe Premiere course? 

We are going to click the Toggle Animation button to the left of Saturation. 

 

Now adjust the value for Saturation. We are going to adjust ours to 0. 

 

Now, move the playhead to the second location so you can set the keyframe for the second effect. 

We are going to move our playhead toward the end of the frame and restore Saturation to 100. 

With the keyframes added, our clip starts out as black and white and turns to color. 

Applying Effects to Multiple Clips Using Keyframes 

Needless to say, you can spend a good bit of time selecting the right effect for a clip, then perfecting 

it using keyframes.   Wouldn't it be nice if you had a way to copy that effect and keyframes so you 

could apply it to other clips in your current and future projects? 
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The good news is you can by creating a preset that you can drag onto a clip in the current project – 

or even a future one. We are going to show you how to do that. 

Copying Effects and Keyframes 

As our example, we are going to copy the effect and keyframes from the last section when we had 

our clip go from black and white to color. 

To copy the effects and keyframes from a clip, go to that clip in the Timeline.  

Next, go to the Effect Controls panel. 

Select the effect that you want to copy, then right click and select Copy. 

 

Now, go back to the Timeline and select the clip you want to paste the effect onto. 

Go to the Effect Controls panel. 

Click anywhere in the panel, right click, then click Paste. 

Creating an Effect Preset 

You can also create an effect preset to that the effect you created can be used in future projects. 

To do this, click the clip that contains the effects in the Timeline. 

Go to the Effect Controls panel. 

Select the effects that you want in the preset, then right click and select Save Preset. 
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You will then see the Save Preset dialogue box. 

 

Type in a name for the preset, then choose a type: 

• Scale will scale the keyframes proportionately over the length of the frame when you apply 

the preset. It deletes existing keyframes. 

• Anchor to In Point applies original keyframes to the beginning of the clip. It does not adjust for 

any differences in duration as with Scale. 

• Anchor to Out Point applies original keyframes to the end of the clip without adjusting for du-

ration. 

Click OK to save the preset. 

You will be able to find the preset in the Presets folder in the Effects panel. 

Keying and Compositing 

Compositing is defined as combining two images in a scene and making it appear as if they were 

shot together. 
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Keying is also known as greenscreening or chromakeying. It involves replacing a color in an image 

with parts from a background image. Typically, the color green is replaced with a background im-

age.   Greenscreening is used for network news during weather forecasts. 

The Ultra Key effect in Premiere Pro makes keying really easy. However, here are some things you 

can do to make it even easier for you: 

1.        Use a camera that has a raster sensor. 

2.        Use a camera that does not interpolate to attain HD resolution. HDV cameras do this. 

3.        Use a camera with a high ISO starting value.  

4.        Use the camera with no gain. 

5.        When you record your footage, record in progressive instead of interlaced format. 

6.        Record at the highest bitrate. 

7.        Make sure the background is evenly lit.  

8.        If you are filming one subject, such as a person, use a tripod L bracket and mount the camera 

vertically for higher resolution and higher pixel density around the subject. 

For keying, you will record your subject with a certain color background, usually green. You will 

want to make sure the subject does not wear any green so parts of the wardrobe are not cut out. 

Using the Ultra Key Effect 

Create a sequence using your greenscreen footage that you shot with your camera by dragging it to 

the New Item button in the Project panel.   

When you do this, you will be able to see the footage in the Program Monitor. 

At this point, you can rename the sequence if you want and even organize it in a bin. 

Next, go to the Effects tab.  Find the Ultra Key effect by typing "ultra" in the search box (in the Effects 

panel). 

Now drag the Ultra Key effect to the clip in the sequence. 

Keying Out a Color 

To key out a color (green for greenscreening), go to the Effect Controls tab.  

You will see the Ultra Key effect. 
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Hover your mouse over the eyedropper tool. The mouse pointer will then change to an eyedropper 

tool. 

 

Use the eyedropper pointer to select the background color in your clip showing in the Program Mon-

itor.  

When you do this, the background color changes to black. If you had a green background, it would 

now be black. 

Next, go to the Effect Controls panel again. 

Select Alpha Channel in the Output menu. 
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Now your video clip is a black and white clip.  

Select a Setting Preset. 

We are selecting Aggressive. You can try each preset to find one that works best for you. 

 

Next, click the triangle to the left of Matte Generation.   You will then see Transparency, Highlight, 

Shadow, Tolerance, and Pedestal. 
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These will adjust how the matte is interpreted.  

Repeat this step for Matte Cleanup, Spill Suppression, and Color Correction. 

Drag the sliders to the right to increase the effect of the adjustment or to the left to decrease the ef-

fect. 

 

Once you are finished with all the adjustments, select Composite from the Output menu. 

You will then see the key in the Program monitor. 

Next, move the keyed clip to Track V2 if it is not already showing there. 

Drag the background to V1. Your background should always be on a lower track. 

Right click on the background. Select Scale to Frame Size. 

When that is finished, select the video clip in the Timeline.  

Go to the Effect Controls panel. 

Click the triangle to the right of Motion Controls. Now you can adjust Position, Scale, and Rotation.  

Cleaning Up the Edges around a Key 

You can remove unwanted edges around a greenscreen key by using a garbage matte. 

To use a garbage matte, go to the Effects panel. The garbage matte effect is found in the same folder 

as the Ultra Key effect. 
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Drag and drop one of the garbage mattes onto the keyed footage. 

 

Drag the effect onto the foreground clip. 

Next, go to the Effect Controls panel. 

Go to the Garbage Matte effect. 

 

We chose an Eight Point Garbage Matte, so we see eight handles appear around the footage. 

Grab a handle and bring them in (one handle at a time) until it is like you need it to be. 

When you are finished, click an empty space in the Timeline.  
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About Premiere Pro video transitions 

Transitions are what bring viewers from one video clip to another. The goal of adding a transition is 

to make this journey completely seamless. A perfect transition should go completely unnoticed by 

your audience. Some really basic transitions can even be made yourself without the use of any sort 

of effects or plugins. 

How to add transitions in Premiere Pro 

Adding transitions in Premiere Pro is similar to adding video effects. Like video effects, transitions 

can be created manually or through the use of templates. Most users will be going the template 

route when it comes to transitions. 

In Adobe Premiere Pro, transitions are actually found in the effects panel. This panel has folders 

containing video transitions and audio transitions.  

 

All you need to do to add a transition is to drag and drop the transition you want onto your respec-

tive video clip. You’ll need to drag the transition over either the end or the beginning of the clip. 
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You can also add a transition on two different clips by dropping the effect in the middle of both. You 

may need to zoom in to your timeline to properly view the transition effect which will show up as a 

small rectangle. You can then change the scale and speed of the transition by grabbing onto the 

edges and adjusting it like you would a video clip. 

 

If you right-click on the transition, you’ll be able to change the duration of the transition manually as 

well as delete it entirely. Something to note is that transitions can take up a lot of processing power. 

It’s important to check what your computer compatibility is before utilizing a lot of transitions. 

 

 



Video Editing  57 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

Editing transitions in Premiere Pro 

As mentioned before, transitions can be edited by dragging and right-clicking on them. They can also 

be adjusted by going to the effects control panel in the upper left-hand of Premiere. Here, users are 

given more precise control over their transitions. 

 

5 useful transition ideas 

The transitions you use should always match the work you’re creating. It can be easy to get carried 

away and start using bombastic transitions such as the glitch transition for your content. While 

these types of transitions might look cool, they’re not always the most practical. Remember, transi-

tions should be seamless and shouldn’t take up a ton of time. 

There are, generally, a few expectations to this rule though. Hyper-stylized content thrives off of 

bombastic transitions. Things such as music videos, animations, and film genres like comedies use 

crazier transitions as a way to match the tone. Like anything, transitions are a creative choice that 

needs to match the type of content being made. 

1. J Cut 

The J Cut is a wildly simple and effective transition that is used constantly, often without people even 

realizing it. The J Cut is done by un-linking the audio on two clips and then moving the audio on one 

clip so that it overlaps with the second. Even though there’s a hard visual cut between the first and 

second clip, the audio of the second clip coming in gives the illusion of a smooth transition. 
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The J Cut is something used in countless films and documentaries. It’s a great transition for those 

creating films, vlogs, documentaries, or really any type of lifestyle content because of how natural it 

is. 

2. Cross Dissolve 

The Cross-Dissolve is such a seamless yet effective transition. A cross dissolve is simply fading one 

clip’s opacity to zero while fading the other all the way up to one hundred. This can either be done by 

changing the opacity of the clip manually or by adding in the Cross-Dissolve template from the ef-

fects pannel. 

 

Cross dissolves have so many use cases. Often, it’s meant as a slow, subtle way of bringing the 

scene from one location to the next. It’s great for content with a calmer pace, working particularly 

well in long-form content. 

3. Cross Zoom 

The Cross Zoom is a more bombastic transition, but great for social media content or videos that 

have high energy to them. The Cross Zoom is Adobe Premiere’s only zoom transition preset and is 

great to have around if you don’t feel like animating while you’re video editing. That being said, the 

Cross Zoom can also be done manually by using keyframes if you so desire. 
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4. Dip to Black 

Dip to Black or fade to black is a great transition for opening or closing your video. This is, again, 

most common in narrative films and documentaries. All this is doing is setting the opacity of the 

screen to zero, leaving it completely in darkness. 

What this transition does is gives a sense of finality and closure or signify the start of something 

new. Fading to black can also be used to separate acts in a story or to signify the half-way-point in a 

piece of media. 

  

 

5. Morph Cut 

While this is can be more of an effect than a transition, it’s getting included simply because of how 

Adobe classifies it. The Morph Cut is incredibly useful for those who shoot and edit a lot of inter-

views. The Morph Cut takes two clips and blends them together to create one seamless clip. For 
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example, if you have an interview where the interviewee stutters, you can cut out the stutter, add the 

Morph Cut, and make the entire sequence appear seamless. 

While this isn’t always a perfectly seamless transition, when it works it really works. Just make sure 

that there isn’t any camera shake or quick speech patterns in the two clips where the morph cut is 

being applied. 

 

Tips for improving your Premiere Pro transitions 

The great thing about transitions in Premiere Pro is how versatile they are. You can even bring clips 

into After Effects using the Adobe Dynamic Link to create even more complex transitions. There is 

also a slew of transition templates online for Premiere Pro for both Mac and Windows. 

Some of these are free transitions while others will cost you. Transitions available online usually 

come in transition packs as well (some being a free download while others being paid). 

Save time with default transitions 

The most efficient way to use transitions is by using the default premiere pro templates. These free 

premiere transitions are simple and take up zero editing time. We went over five of the most useful 

ones today, but there are dozens to check out in the effects panel. 

Use consistency 
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It’s crucial that your transitions are consistent throughout your project. Drastically changing the 

types of transitions being used throughout your project can be distracting for the viewer. It’s best to 

stick to a few transitions while editing for the sake of consistency. 

Don’t overdo it 

Transitions are something that can be so easy to overdo. The most professional-looking videos 

though are the ones with very minimal transitions. Overdoing your transitions can come off as ama-

teurish if you don’t know what you’re doing. That’s why the best premiere transitions are the ones 

that completely blend in. 

Opacity blend modes Adobe Premiere Pro  

The blend mode menu is subdivided by white lines into six distinct groups. These groups are as fol-

lows: 

• Normal. 

• Subtractive. 

• Additive. 

• Complex. 

• Difference. 

• HSL. 

 

Normal Category 

“The result color of a pixel is not affected by the color of the underlying pixel unless opacity is less 

than 100% for the source layer.” 

Essentially, the normal blending modes apply the source color to the underlying color — or you are 

blending the image and color of your top video over your bottom one. 

 

Normal 

“The result color is the source color. This mode ignores the underlying color. Normal is the default 

mode.” 

Dissolve 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/normal.png
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“The result color for each pixel is either the source color or the underlying color. The probability that 

the result color is the source color depends on the opacity of the source. If the opacity of the source 

is 100%, then the result color is the source color. If opacity of the source is 0%, then the result color 

is the underlying color.” 

 

Subtractive Category 

“These blend modes tend to darken colors, some by mixing colors in much the same way as mixing 

colored pigments in paint.” 

The Subtractive category takes into account the luminosity values and color information of both 

Source and Underlying layers when selecting output color values for the result color. This will usu-

ally result in a net darkening of the result image. 

 

Darken 

“Looks at the color information in each channel and selects the base or blend color — whichever is 

darker — as the result color. Pixels lighter than the blend color are replaced, and pixels darker than 

the blend color do not change.” 

Multiply 

“Looks at the color information in each channel and multiplies the base color by the blend color. The 

result color is always a darker color. Multiplying any color with black produces black. Multiplying 

any color with white leaves the color unchanged. When you’re painting with a color other than black 

or white, successive strokes with a painting tool produce progressively darker colors. The effect is 

similar to drawing on the image with multiple marking pens.” 

Color Burn 

“Looks at the color information in each channel and darkens the base color to reflect the blend color 

by increasing the contrast between the two. Blending with white produces no change.” 

Linear Burn 

“Looks at the color information in each channel and darkens the base color to reflect the blend color 

by decreasing the brightness. Blending with white produces no change.” 

Darker Color 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/Subtractive.png


Video Editing  63 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

“Compares the total of all channel values for the blend and base color and displays the lower value 

color. Darker Color does not produce a third color, which can result from the Darken blend, because 

it chooses the lowest channel values from both the base and the blend color to create the result 

color.” 

 

Additive Category 

“These blend modes tend to lighten colors, some by mixing colors in much the same way as mixing 

projected light.” 

Essentially, these blend modes compare luminosity values and use the values to determine which 

layer’s information to output. This will usually result in a net lightening of the result image. 

 

  

Lighten 

“Looks at the color information in each channel and selects the base or blend color — whichever is 

lighter — as the result color. Pixels darker than the blend color are replaced, and pixels lighter than 

the blend color do not change.” 

Screen 

“Looks at each channel’s color information and multiplies the inverse of the blend and base colors. 

The result color is always a lighter color. Screening with black leaves the color unchanged. Screen-

ing with white produces white. The effect is similar to projecting multiple photographic slides on top 

of each other.” 

Color Dodge 

“Looks at the color information in each channel and brightens the base color to reflect the blend 

color by decreasing contrast between the two. Blending with black produces no change.” 

Linear dodge (add) 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/Additive.png
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“Looks at the color information in each channel and brightens the base color to reflect the blend 

color by increasing the brightness. Blending with black produces no change.” 

Lighter color 

“Compares the total of all channel values for the blend and base color and displays the higher value 

color. Lighter Color does not produce a third color, which can result from the Lighten blend, because 

it chooses the highest channel values from both the base and blend color to create the result color.” 

 

Complex Category 

“These blend modes perform different operations on the source and underlying colors depending on 

whether one of the colors is lighter than 50% gray.” 

The Complex blend group will have varying results depending on the footage you feed it. It uses the 

gray information to decide which of the layers to output to result. 

 

Overlay 

“Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the exist-

ing pixels while preserving the highlights and shadows of the base color. The base color is not re-

placed, but mixed with the blend color to reflect the lightness or darkness of the original color. ” 

Soft Light 

“Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a dif-

fused spotlight on the image. If the blend color (light source) is lighter than 50% gray, the image is 

lightened as if it were dodged. If the blend color is darker than 50% gray, the image is darkened as if 

it were burned in. Painting with pure black or white produces a distinctly darker or lighter area, but 

does not result in pure black or white.” 

Hard Light 

“Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a 

harsh spotlight on the image. If the blend color (light source) is lighter than 50% gray, the image is 

lightened, as if it were screened. This is useful for adding highlights to an image. If the blend color is 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/Complex.png
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darker than 50% gray, the image is darkened, as if it were multiplied. This is useful for adding shad-

ows to an image. Painting with pure black or white results in pure black or white.” 

Vivid Light 

“Burns or dodges the colors by increasing or decreasing the contrast, depending on the blend color. 

If the blend color (light source) is lighter than 50% gray, the image is lightened by decreasing the 

contrast. If the blend color is darker than 50% gray, the image is darkened by increasing the con-

trast. ” 

Linear Light 

“Burns or dodges the colors by decreasing or increasing the brightness, depending on the blend 

color. If the blend color (light source) is lighter than 50% gray, the image is lightened by increasing 

the brightness. If the blend color is darker than 50% gray, the image is darkened by decreasing the 

brightness.” 

Pin Light 

“Replaces the colors, depending on the blend color. If the blend color (light source) is lighter than 

50% gray, pixels darker than the blend color are replaced, and pixels lighter than the blend color do 

not change. If the blend color is darker than 50% gray, pixels lighter than the blend color are re-

placed, and pixels darker than the blend color do not change. This is useful for adding special effects 

to an image.” 

Hard Mix 

“Adds the red, green, and blue channel values of the blend color to the RGB values of the base color. 

If the resulting sum for a channel is 255 or greater, it receives a value of 255; if less than 255, a 

value of 0. Therefore, all blended pixels have red, green, and blue channel values of either 0 or 255. 

This changes all pixels to primary additive colors (red, green, or blue), white, or black.” 

 

Difference Category 

“These blend modes create colors based on the differences between the values of the source color 

and the underlying color. ” 

Simply put, these modes will create colors not found in the original images based on the color infor-

mation of each layer. 
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Difference 

“Looks at the color information in each channel and subtracts either the blend color from the base 

color or the base color from the blend color, depending on which has the greater brightness value. 

Blending with white inverts the base color values; blending with black produces no change.” 

Exclusion 

“Creates an effect similar to but lower in contrast than the Difference mode. Blending with white in-

verts the base color values. Blending with black produces no change.” 

Subtract 

“Looks at the color information in each channel and subtracts the blend color from the base color. In 

8- and 16-bit images, any resulting negative values are clipped to zero.” 

Divide 

“Looks at the color information in each channel and divides the blend color from the base color.” 

 

HSL Category 

“These blend modes transfer one or more of the components of the HSL representation of color 

(hue, saturation, and luminosity) from the underlying color to the result color.” 

The HSL category is the easiest to understand (for me). It simply transfers the selected value (Hue, 

Saturation, Color, or Luminance) from the Underlying layer to the result image. 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/Difference.png
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Hue 

“Creates a result color with the luminance and saturation of the base color and the hue of the blend 

color. ” 

Saturation 

“Creates a result color with the luminance and hue of the base color and the saturation of the blend 

color. Painting with this mode in an area with no (0) saturation (gray) causes no change. ” 

Color 

“Creates a result color with the luminance of the base color and the hue and saturation of the blend 

color. This preserves the gray levels in the image and is useful for coloring monochrome images and 

for tinting color images.” 

How to Stabilize a Shaky Video in Premiere Pro 

With Adobe Premiere Pro, you can stabilize shaky footage using their handy Warp Stabilizer tool.  

Step 1: Select the video you want to stabilize and add it to the timeline. 

Step 2: Go to your “Effects” workspace and locate the Effects folders. 

 

https://www.premiumbeat.com/blog/wp-content/uploads/2018/07/HSL.png
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Step 3: Choose the Video Effects folder and open it. 

Step 4: Scroll down to "Distort," open it, and double-click on "Warp Stabilizer" 

 

Step 5: Premiere will now "Analyze" your footage for stabilization; this may take a minute or two.  

 

 

Step 6: Once the footage is analyzed, Premiere will now stabilize it using its stabilizing algorithm. 

Step 7: Review your footage to see how much shake Warp Stabilizer was able to remove! 

Now, the results of Warp Stabilizer may vary. If the clip is too dark or there is too much shake, it may 

not be able to correctly render and correct the footage.  
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Masking in Premiere Pro 

Masks let you define a specific area in a clip that you want to blur, cover, highlight, apply effects, or 

color-correct. You can create and modify different shaped masks, like an Ellipse or a Rectangle. Or, 

you can draw free-form Bezier shapes using the Pen tool. 

Create masks using shapes 

You can use the Ellipse shape tool to create a circular or ellipse-shaped mask, or a Rectangle shape 

tool to create a four-sided polygon. 

 

Before masking 

 

After masking 

1. In the Timeline panel, select the clip you want to mask. 

2. From the Effects panel, select the effect that you want to apply to the clip. 

For example, if you want to apply the Mosaic effect, select Video Effects > Stylize > Mosaic. 
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3. Apply the selected effect to a clip by dragging the effect from the Effects panel to the clip in 

the Timeline panel. Alternatively, select the clip and double-click an effect in the Effects panel 

to apply it. 

  

 

Add mosaic effect to a clip 

 

 

 

 

    

 

4. Ellipse, rectangle, pen tool 

Open the Effect Controls panel to see the effect properties. Click the drop-down arrow to reveal the 

controls. 

You can create an ellipse or rectangle. Use the Pen tool to create free form shapes.  

You can specify values to adjust a mask using the Effect Controls panel. The controls change de-

pending on your choice. For more information, see Adjust mask settings. 

5. Click the Ellipse shape tool to create an Ellipse-shaped mask or click the Rectangle shape 

tool to create a rectangle-shaped mask. 

The shape mask appears in the clip displayed in the Program Monitor, and the effect is constrained 

within the masked area. 
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Ellipse 

6. You can now customize the size and shape of the mask using the Effect Controls panel. For 

more information on editing your mask, see Adjust mask settings. 

 

Create a mask using the Ellipse tool 

Create free-form shapes 

You can create free-form shapes using the Pen tool. The Pen Tool lets you freely draw complex mask 

shapes around objects. 

Select the Pen tool from the Effect Controls panel. Draw directly on the clip in the Program Monitor. 
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Create a free form shape using the Pen tool 

You can create different shapes by drawing straight lines and curved segments. To draw smooth 

curves, you can draw Bezier path segments that provide you greater control over the shape of the 

mask.   

Draw straight path segments with the Pen tool 

The simplest path that you can draw with the Pen tool is a straight line with two vertex points. By 

continuing to click, you create a path made of straight-line segments connected by vertex points. 

This is a linear mask. 

A linear mask is always a polygon with joined by hard angles. Linear control points are also known 

as corner points. 

 

Use the Pen tool to create a linear mask 

1. Select the Pen tool. 

2. Position the Pen tool where you want the straight segment to begin, and click to define the 

first vertex point (do not drag). 

  

Note:  

The first segment you draw is not visible until you click a second vertex point. 

3. Click again where you want the segment to end. 

4. Continue clicking to set vertex points for additional straight segments. 

5. To draw perfect 0°, 45°, or 90° angles, press Shift + click on the keyboard. 

6. To close the path with a linear mask, Alt+click (Windows) or Option+click (macOS) over the 

first vertex point.  

Draw curved Bezier path segments with the Pen tool 

You create a curved path segment by dragging direction lines using the Pen tool. The length and di-

rection of the direction lines determine the shape of the curve. 
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To create Bezier shapes, you convert a vertex point on a mask to a Bezier point by pressing the Alt 

key while placing the cursor over the vertex point. The cursor becomes an inverted "V" shape  . 

Then, click and release the pointer. 

Bezier handles provide two-directional controls that allow you to change the curve of the line seg-

ment between the handle and the next point on either side. 

 

A. Two-directional Bezier handles to control the shape of the curve  B. Bezier mask points   

1. Place the Pen tool where you want the curve to begin, and hold the mouse button down. A 

vertex appears, and the Pen tool pointer changes to an arrowhead. 

2. Drag to modify the length and direction of both direction lines for a vertex, and then release 

the mouse button. 

A. Placing the Pen tool 
B. Starting to drag (mouse button pressed) 
C. Dragging to extend direction lines 

 

Drawing the first vertex in a curved path 

3. Place the Pen tool where you want the curved segment to end, and do one of the following: 
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• To create a C-shaped curve, drag in the direction opposite from the direction that you 

dragged the previous direction line, and then release the mouse button. 

A. Starting to drag 

B. Dragging away from previous direction line, creating a C curve 

C. Result after releasing mouse button 

 

Drawing the second vertex in a curved path 

• To create an S-shaped curve, drag in the same direction as the previous direction line, 

and then release the mouse button. 

A. Starting to drag 

B. Dragging in same direction as previous direction line, creating an S curve 

C. Result after releasing mouse button 

 

Drawing an S curve 

4. Continue dragging the Pen tool from different locations to create a series of smooth curves. 

Modifying and moving masks 

The vertex points on a mask let you easily manage the shape, size, and rotation of a mask. 

Modify the shape, size, and rotation of a mask 
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To change the shape of a mask, drag a mask handle. 

 

To change the shape of an ellipse mask to a polygon, press Alt and click any of the vertices of the 

ellipse. 

 

To resize a mask, place your cursor just outside a vertex and press Shift (cursor becomes a double-

sided arrow ), then drag the cursor. 
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To rotate the mask, place your cursor just outside a vertex (cursor becomes a curved double-sided 

arrow ), and then drag.  

Move, add, or remove a vertex 

 

To move a vertex, drag the vertex with the Selection tool. Note that while dragging an ellipse-shaped 

mask, the ellipse shape is not maintained. 

 

To add a vertex, place your cursor over a mask edge while pressing Ctrl (Windows) or Cmd (macOS). 

The cursor changes to a pen shape with a "+" sign .  
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To remove a vertex, place your cursor over the point while pressing Ctrl (Windows) or Cmd (macOS). 

The cursor changes to a pen shape with a minus sign .  

Other important commands and keyboard shortcuts 

• Use the arrow keys on your keyboard to nudge a selected control point by a distance of one 

unit. 

• Press Shift and use the arrow keys to nudge a selected control point by a distance of five 

units. 

• To deselect all the selected control points, click outside a currently active mask. 

• To disable direct manipulation of a mask, click outside the mask. Or deselect the clip in the 

sequence. 

• To delete a mask, select the mask in the Effect Controls Panel and press Delete on your key-

board. 

Adjust mask settings 

You can specify values to adjust a mask using the Effect Controls panel. You can feather the mask, 

expand the mask, change the opacity, or invert the mask to stylise your video. 

 

Adjust mask settings 

Apply mask feathering 
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To feather a mask, specify a Mask Feather value. The feathering guide appears around the mask as a 

dashed line. Drag the handle away from the feathering guide to increase the feathering, or toward 

the feathering guide to decrease the feathering. 

The mask feather handle lets you control the amount of feathering directly on the mask outline in 

the Program Monitor.  

Adjust mask opacity 

 

When opacity is applied to a mask it will change the opacity of the footage you have cropped out. 

To adjust the opacity of a mask, specify a Mask Opacity value. The slider controls the mask opacity. 

At  a value of 100, the mask is opaque and blocks out any underlying area of the layer. As you lower 

the opacity, more of the area under the mask becomes visible. 

Adjust mask expansion 
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To expand a mask, specify a Mask Expansion value. Positive values move the borders outward, and 

negative values move it inward. You can also drag the handle away from the expansion guide to ex-

pand the mask area, or toward the expansion guide to contract the mask area.    

Invert mask selection 

 

Select the Inverted check box to reverse the masked and unmasked areas. 

You can protect areas that you want to leave as-is by masking it, and select the Inverted check box 

to apply effects to the unmasked areas. 

Copy and paste masks 

You can easily copy and paste masks between clips or between effects. 

Copy and paste effects with masks between clips 

When you copy and paste an effect containing masks, the pasted effect has the same masks applied. 

1. In the Timeline panel, select the clip containing the effect with masks. 

2. In the Effect Controls panel, select the effect to copy. 

3. Select Edit > Copy. Or use the keyboard shortcut Ctrl+C (Windows) or Cmd+C (Mac OS). 

4. Select another clip in the Timeline to which you want to paste the mask. 

5. Select Edit > Paste. Or use the keyboard shortcut Ctrl+V (Windows) or Cmd+V (Mac OS). 

  

Copy and paste masks between effects 

1. In the Effect Controls panel, click the triangle to expand the effect to reveal the applied 

masks. 

2. Select the mask to copy. 

3. Select Edit > Copy. Or use the keyboard shortcut Ctrl+C (Windows) or Cmd+C (Mac OS). 

4. Select another effect in the Effect Controls panel to which you want to paste the mask. 
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5. Choose Edit > Paste. Or use the keyboard shortcut Ctrl+V (Windows) or Cmd+V (Mac OS). 

Mask tracking in Premiere Pro 

When you apply a mask to an object, Premiere Pro can let the mask automatically follow the object 

as it moves from one frame to another. For example, after blurring a face using a shape mask, 

Premiere Pro can automatically track the movements of the masked face from frame to frame as the 

person moves. 

When a mask is selected, the Effect Controls panel displays controls for tracking the mask forward 

or backward. You can choose to track the mask either one frame at a time or until the end of the se-

quence. 

Click the wrench icon  to modify how masks are tracked. You can select from a few choices to 

provide the most effective tracking: 

Position 

Tracks just the mask position from frame to frame 

Position And Rotation 

Tracks the mask position while changing the rotation as required per frame 

Position, Scale, And Rotation 

Tracks the mask position while automatically scaling and rotating as the frame moves 

Note:  

You can find the option that works best for your clip by trial. Select one of these options, and if it 

doesn't work well, undo, and try another one. 

To use the more advanced tracking features available in After Effects, send your sequence to After 

Effects using the Dynamic Link feature. For more information, see Mask Tracking in After Effects. 

Speed up mask tracking 

Mask tracking in Premiere Pro is faster when Live Preview is disabled (the default option). If for 

some reason, Live Preview is enabled, you can disable it using the following procedure. 

1. In the Timeline panel, select the clip containing the effect with masks. 

2. To preview the changes in the track, click the mask wrench icon  and select preview from 

the drop-down list. 
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Mask preview 

3. To disable live preview, click the mask wrench icon  and deselect preview from the drop-

down list. 

 

Disable live preview 

In addition, Premiere Pro has in-built features that optimize mask tracking:   

For clips with a height greater than 1080, Premiere Pro scales the frame to 1080 before calculating 

the track. Also, Premiere Pro uses Low Quality renders to speed up the process of mask tracking. 

What is a cut in Video Editing 

Video cuts (also called movie cuts or film cuts) are transitions in films and videos that allow 

filmmakers to weave multiple camera shots together. These transitions play a key role in visual sto-

rytelling, and it’s on the editor to choose the best types of cuts to serve the film’s core narrative. 

The term “cutting” dates back to the days of celluloid film, when directors and editors would spend 

their post-production time literally slicing and splicing strips of film to create smooth transitions 

between shots and scenes. 

In the modern film industry, video editors no longer wield utility knives. They hone their editing tech-

nique on the computer, where powerful programs like Adobe Premiere, Vegas Pro, Final Cut Pro X, 

and Descript can cover all the major cuts used by professional editors. When you watch just about 

any new movie or TV show, you’re seeing cuts that an editor digitally rendered on a computer. 

10 different types of video cuts 

Today’s video editing software makes adding and editing cuts simpler than ever before. Whether 

you’re editing your video project in a legacy program like Adobe Premiere or an AI-driven platform 

like Descript, you’ll need working knowledge of the basic types of cuts available so your videos can 

look professional and tell a story the way you want them to. 

1.  Standard cut 

The standard cut, also known as the hard cut, is a classic editing technique where one scene goes to 

the next with no visual transition. In a script, cuts like these are often called “smash cuts.” You can 

see an assortment of smash cuts in Quentin Tarantino’s Django Unchained (2012) in a dining room 

scene where ruthless slave owner Calvin J. Candie (Leonardo DiCaprio) loses his mind over decep-

tion from Django (Jamie Foxx) and Dr. Schultz (Christopher Waltz). Tarantino cuts to various angles 

in the scene without fanfare, which creates a sense of fluid continuity. 
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2.  J-Cut 

A J-cut is a classic technique where the audio from the next clip overlaps with the video of the pre-

vious clip.  For example, imagine you have two video clips: Clip A and Clip B. In a J-cut, the audio 

from Clip B will begin playing before the video from Clip A concludes. This type of editing is known 

as a split edit. This cut is named for the way it looks in a video editor: the new audio track sticks out 

to the left of the new video track above it to resemble the shape of the letter J. You can see a J-cut 

in action in a scene from Eternal Sunshine of the Spotless Mind (2004) where a tense sequence with 

Joel Barish (Jim Carrey) and Clementine Kruczynski (Kate Winslet) ends with the overlay of audio 

from young children playing outside. 

3.  L-Cut 

An L-cut is the opposite of a J-cut, and it, too, qualifies as a split edit. It cuts to new visuals while the 

audio from the previous shot continues. So if you had Clip A and Clip B, you would continue audio 

from Clip A while cutting to the video of Clip B. In a famous L-Cut from the action film Preda-

tor (1987), a petrified scream from Al Dillon (Carl Weathers) continues into the next visual clip of 

soldiers elsewhere in the jungle. 

4. Jump cut 

Jump cuts are named for the fact that they “jump” ahead or backward in a film’s chronology. They in-

dicate the passage of time. One of the most famous uses of the jump cut occurred in Jean Luc-Go-

dard’s first film Breathless. What could have been a lull in the film’s momentum is brought back to 

life by keeping only the most interesting bits of dialogue. It makes the audience feel as though 

they’re moving through time faster. His use of jump cuts popularized the technique for the rest of the 

film industry. 

5. Cross-cut 

Cross-cutting is the act of cutting back and forth between two sequences. You can cross-cut be-

tween a pair of scenes, or you can cross-cut among multiple scenes in multiple locations. You can 

even cross-cut between two events taking place in the same physical space and on the same exact 

timeline. In the 1990 horror-thriller Misery, director Rob Reiner uses cross-cutting to build suspense 

as novelist Paul Sheldon (James Caan) frantically wheels his wheelchair through the house while 

his captor Annie Wilkes (Kathy Bates) walks up the front path to the door. 

6. Parallel editing 

Parallel editing uses the same back-and-forth technique found in cross-cutting, but its purpose is 

slightly different. Specifically, parallel editing does not necessarily strive for the illusion that two 

scenes are happening simultaneously. Instead, it intercuts to draw thematic comparisons. Alfred 

Hitchcock uses parallel editing masterfully in his opening scene of Strangers of a Train (1951). Show-

ing only his characters’ legs and feet, he cuts back and forth between his two titular “strangers” ar-

riving at a train station in taxis, exiting, walking through the terminal, boarding the train, and finally 

sitting down across from one another. The parallel editing doesn’t end until the characters are face-

to-face. 
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7. Match cut 

A match cut connects two scenes by showing a common element in back-to-back shots. An example 

is one scene ending on the image of someone looking at a globe on a desk and the next scene show-

ing astronauts viewing planet Earth from orbit. One of the most dramatic (and imitated) match cuts 

in all of cinematic history occurs in Stanley Kubrick’s 1968 sci-fi space opera 2001: A Space Odyssey. 

A prehistoric ape tosses a bone in the air and then the film seems to jump roughly one million years 

into the future as the skybound bone becomes a spaceship in flight. 

8. Cutting on action 

Cutting on action means inserting a cut in the middle of an action sequence, like when one person 

throws a punch and we cut to the point of view of their victim watching the fist hurtle toward them. 

For a multi-clip example of cutting on action, check out the scene in The Natural(1984) where Roy 

Hobbs (Robert Redford) strikes out a feared hitter nicknamed “The Whammer” at a county fair. The 

same single pitch involves six different cuts that show seven film clips — a clinic in seamless cutting 

from director Barry Levinson and editor Stu Linder. 

9. Cutaways 

A cutaway is a brief visit from a principal scene to a secondary scene that’s only tangentially related. 

Cutaways are popular in comedy since they can reveal additional information that makes the main 

scene even funnier. You can find a hilarious cutaway sequence in Austin Powers: International Man 

of Mystery, the Jay Roach-directed 1997 spy comedy starring Mike Myers. In a suspense sequence, 

Austin Powers (Myers) has to turn around an electric cart in a narrow tunnel. He attempts to do a 3-

point turn but has little luck. The scene then cuts away to Dr. Evil (also Myers), who is about to exe-

cute the final stages of his diabolical plot, which only Austin Powers can stop. The film then cuts 

back to Austin Powers, now completely stuck in his electric cart with no way to turn around. The cart 

gag is funny enough by itself, but the cutaway makes it a comedy classic. 

10. Montage 

A montage is a series of intercut scenes that provides a narrative, often without dialogue. By cutting 

back and forth among various sequences, directors and editors can reveal how multiple storylines 

converge into a unified whole. Montage sequences often turn up when a character undergoes a 

transformation — whether literal or metaphorical. A great makeover montage can be found in the 

1995 comedy Clueless where Cher (Alicia Silverstone) helps her friend Tai (Brittany Murphy) remake 

her image. As the camera cuts around to various scenes of the high schoolers trying on clothes and 

dying Tai’s hair, Jill Sobule’s song “Supermodel” provides a fitting underscore. 

What is continuity editing? 

Continuity editing uses a variety of classic film editing techniques to blend multiple camera shots — 

some taken at different times or even different locations — into a seamless, consistent narrative. 

This continuous stream helps viewers suspend disbelief so they can fully immerse themselves in a 

story without needless distractions. 
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Naturally, continuity editing includes making sure that items like props or costumes stay consistent 

from scene to scene. But the more important work lies in editing shots together in a way that leaves 

viewers thoroughly grounded in both time and space. 

Film editing techniques designed to provide this grounding include eyeline matching, the 180-degree 

rule, and match cuts. An additional technique, eye trace, can also help guide viewers from one cam-

era shot to another. 

Eyeline matching. 

Directors and film editors use eyeline matching in several different ways. In a complex scene with 

various shots of multiple characters interacting, it can mean clearly defining where each person is 

looking. The way the characters looked at each other in the original wide shot must be consistently 

maintained in any close-ups that are later cut into the scene, even if the shots are filmed at different 

times. 

Eyeline matching also comes into play when a character is interacting with the set. If someone is 

about to bend down and pick up a ball from a field, for example, the first shot should establish their 

line of sight in that direction. This perspective helps the audience follow through when the next shot 

goes to a close-up of the ball itself. 

Finally, eyeline matching can be used as a form of transition, where a character looks toward the 

person or subject that will appear in the next sequence. This helps establish the viewer’s frame of 

reference for the following shot. 

The 180-degree rule. 

The 180-degree rule is a primary continuity principle, designed to maintain consistent spatial geog-

raphy. It helps orient viewers by defining where the characters are located in space — in relation to 

each other, and to their environment. Basically, this guideline imagines an invisible, 180-degree axis 

between characters that establishes who is to the left and who is to the right in a given scene. This 

determines their relative points of view, which in turn makes it possible to maintain the spatial rela-

tionship consistently as they interact in subsequent shots. 

Match cuts. 

Match cuts are often used as transitions, cutting from one scene to another. They differ from regular 

cuts by providing a thematic element that connects the two scenes. This connection helps move the 

viewer along as well. These edits can be audio, visual, or both, but they all match some specific ele-

ment of a scene — action or subject matter — to a corresponding element in the following scene. 

Graphic match cuts use shapes, colors, or other compositional elements to create visual metaphors 

or add other symbolic meaning. (One of the most famous graphic matches in cinema occurs at the 

beginning of Stanley Kubrick’s 2001: A Space Odyssey, where the bone club hurled into the sky by a 

prehistoric ape transition seamlessly into a futuristic satellite.) 

Another useful type of match cut is the sound bridge, where some form of audio (voice-over, sound 

effects, dialog, or music) is used to guide the viewer from one scene to the next. For example, a di-

rector might use recurring theme music to provide continuity whenever a main character appears or 

a certain type of event occurs. (Just think of Ennio Morricone’s unforgettable scores for the Sergio 
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Leone Spaghetti Westerns, especially The Good, the Bad and the Ugly.) In Star Wars — often de-

scribed as a “space opera” — John Williams literally borrowed from opera to compose Wagnerian-

style leitmotifs like the “Imperial March” that propels Darth Vader into his scenes. 

The match on action cut is one of the most useful tools in continuity editing. Sometimes called “invis-

ible editing” because it is so basic and universal, the match on action cut maintains the flow of action 

between two shots. The second shot, from a different view, matches or continues the action of the 

first shot. This can be within the same scene, or in adjacent scenes. It can be the literal continuation 

of a movement carried over into the next frame, or the logical conclusion of an action, as when the 

shot of someone’s hand on a doorknob is immediately followed by a shot of the door opening. 

That’s just basic physical continuity. Now consider the “action” scene. Clearly, no coherent action se-

quence could be assembled without dozens of continuity edits to sync up the punches thrown and 

landed, the car wheels careening around the curve, or the dramatic fall from a plane. These are all 

match on action cuts. By helping generate narrative momentum, they also play a vital role intensify-

ing the action itself. 

Eye trace. 

The eye trace technique is primarily a storytelling device in continuity editing. It focuses the viewer’s 

attention — their eye — to the desired area of a frame through blocking, camera use, color, lighting, 

or cuts. For example, a director might repeat a certain color in the following frame to subtly guide 

the viewer’s gaze in that direction. 

Eye trace controls what the audience sees by making strategic choices that will influence the way 

they view consecutive edits. Where was the viewer’s eye focused on the last frame? Where will that 

lead them to look first in the next frame? How would a potential cut affect that focal path? This can 

be a powerful technique when the filmmaker wants to emphasize — or hide — specific details. 

What about discontinuity? 

Continuity errors aren’t always a mistake. Sometimes even great directors and film editors choose 

to keep a flawed take because it was the best performance of a given scene. 

And sometimes discontinuity is just what the filmmaker was after. If continuity means the logical 

presentation of a rational universe in a way that feels realistic to viewers, discontinuity may be the 

best way to present an irrational, completely alien world. Science fiction movies, horror flicks, psy-

chological thrillers, indie features, and experimental films have all benefited from disorienting and 

even disturbing the audience in order to tell their stories in the most effective way. 

Jagged jump cuts, jumbled chronology, fractured logic, and warped perspectives — these are all le-

gitimate editing techniques when used deliberately, for the right reasons. To take just one exam-

ple, The Shining (Kubrick again) is famous for its many discontinuities, even breaking the supposedly 

sacred 180-degree rule. 
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Defining Rhythm and Pacing in Film 

Rhythm in film refers to the pattern of beats and pauses that dictate the flow of the narrative. Just 

like music, rhythm in filmmaking is about creating a harmonious and engaging sequence of events 

that resonate with the audience. It is the pulse that guides the viewer through the story, leaving them 

captivated by the filmmaker’s artful orchestration of images, sounds, and emotions. The rhythm 

helps set the tone and mood of the film, accentuating key moments and intensifying emotions. 

On the other hand, pacing in film is the speed at which the narrative unfolds. It is the measure of 

how quickly or slowly the story progresses, affecting the overall tempo and energy of the film. 

Proper pacing ensures that the audience remains engrossed and invested in the unfolding events, 

preventing boredom or confusion. 

Sources of Confusion 

One of the primary sources of confusion between rhythm and pacing is their inherent connection. A 

well-crafted rhythm can affect the film’s pacing, and vice versa. Filmmakers must recognize that 

while rhythm dictates the flow of events, pacing determines the duration of each event. Conse-

quently, the interplay between these elements can make or break a film. 

Furthermore, filmmakers often struggle to find the balance between maintaining a consistent 

rhythm throughout the film and allowing the pacing to adapt to the story’s emotional demands. A 

film’s rhythm might follow a consistent pattern, but there will be moments when the pacing needs to 

vary to emphasize certain emotions or build suspense. 

Intertwining Rhythm and Pacing 

Achieving a seamless integration of rhythm and pacing requires a thoughtful approach from the be-

ginning stages of pre-production. Producers, filmmakers, and editors should collaborate closely to 

align their vision for the film’s rhythm and pacing. Here are some essential tips for effectively inter-

twining these concepts: 

Storytelling Objective  

Define the storytelling objective and identify the emotional beats of the narrative. Understanding the 

peaks and valleys in the story will aid in establishing the film’s rhythm and determining the appro-

priate pacing. 

Internal and External Rhythm 

Internal rhythm relates to the emotional and psychological pace within the characters and the nar-

rative. External rhythm, on the other hand, involves the physical pace dictated by the editing and cin-

ematography. A seamless blend of both internal and external rhythm ensures a captivating film ex-

perience. 

Timing and Pacing 

Pay careful attention to the timing of each scene and shot. Sometimes, a single shot can linger for 

an extended period to heighten tension or evoke emotions. Other times, quick cuts may be neces-

sary to intensify action sequences. 
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How To Do Speed Ramping (Time Remapping) In Adobe Premiere Pro 

When you want some parts of your video to be fast and some parts to be slow, you need to apply 

speed ramping or time remapping to the video. Follow this method to make your videos more cine-

matic and interesting! 

1. Choose the clip you want to edit 

Right-click or Ctrl-Click the clip you want to edit. 

 

2. Show Clip Keyframes 

Choose Show Clip keyframes > Time Remapping > Speed. 

 

3. Create Keyframes 

Select the Pen tool from the Tools panel, and click on the white line over top of the clip, which repre-

sents speed. Click at the beginning and end of where you want your speed to change. 
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4. Increase speed or decrease speed 

• Choose the Selection tool from the Tools panel, and then drag the white line up to increase 

the speed, or down to decrease the speed. The percentages will show on the screen. 

• Now the speed will change throughout the clip, but the speed changes will be sudden and ab-

rupt. 

 

5. Create a ramping effect 

Drag half the keyframe to the left or right to change the length of the ramp. Now the speed will 

change gradually over time and be smoother. 

 

6. Move the entire keyframe 
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If you need to, you can Opt-Drag or Alt-Drag  a keyframe to the right or left to fine-tune the location 

of it. 

 

 

Sequence In Adobe Premiere Pro 

The editing sequence is the area where video clips are arranged and built into your story. How you 

set this up will dictate several things about how your final piece looks, the most obvious being the 

size and aspect ratio of the video. You’re probably familiar with terms such as 1080p, 720p, and 16:9 

or 1:1, these are all various project settings you might need to use. 

Before you begin editing, you will need to define your sequence settings. What you choose will often 

depend on the format you wish to export your project in. For example, you might need the final clip 

to be square for sharing on Instagram, or horizontal for Facebook. You might also need to use spe-

cific settings depending on the camera used and the frame rate of your footage. 

Sequence Presets Overview 

The sequence settings you choose will most likely be dictated by the output you want to achieve. A 

great shorthand to understanding sequence settings is to look at the most common uses for the 

content you create. If you regularly work on projects for social media sharing, you will likely need to 

use the same settings each time. 

While this chart is a great shorthand for some of the most commonly used sequence settings, it’s 

important to remember that as you get more advanced in your editing you will find more opportuni-

ties to use the other settings Premiere Pro has available. 

Best Settings For Timebase* Frame Size Aspect Ratio 

YouTube HD 23.976 1080×1920 16:9 

Instagram HD (Square) 23.976 1080×1080 1:1 

Instagram Stories HD (portrait) 23.976 1920×1080 9:16 

UHD / 4K 23.976 2160×3840 16:9 
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*The timebase settings are for your frames per second, and these can be changed depending on how 
you want the footage to look. We prefer to use 23.976 fps as it gives a more cinematic feel to your 
video. 

Part 2: How to Get the Right Sequence Settings 

Fortunately, Premiere Pro has 2 ways to ensure the sequence settings match your footage settings 

without you needing to delve into customizing them. 

1. Create a Sequence from a Clip 

This method is the easiest way to ensure your sequence and clip settings match. It can also be a 

great way to organize your projects, so long as you intend to export your video using the same set-

tings your footage was shot in. 

1. Create a new Project and import your footage. 

2. In the Project Browser, select a clip. 

3. Right-click on the clip, and select New Sequence from Clip. 

2. Add a Clip to an Empty Timeline 

If you have already created a sequence but are not sure if it has the right settings for your footage, 

Premiere Pro will tell you if they are mismatched. 

1. Create a new Sequence, using any settings from the available options. 

2. Find a clip in your Project Browser, and drag it to the Timeline panel. 

3. Premiere Pro will notify you if they do not match and will give you 2 options: keep the se-

quence settings as they are, or change them to match the clip. 

4. Select Change the Sequence to match the clip, and your settings will update. 

Part 3: How to Customize Your Sequence Settings 

If you’re going to be working with multiple video formats or you simply want to input your own set-

tings rather than relying on your clips, you can customize your sequence settings before you begin 

editing. 

Step 1: Create a Custom Sequence 

The first step is to decide what settings you want to use. Refer to the table at the top of this tuto-

rial for the most common uses. 

1. Go to File > New > Sequence (or press Cmd+N or Ctrl+N) to open up the settings window. 

2. Select Settings at the top tab. 

3. In the editing mode, select Custom. 

4. Change your Timebase and Frame Size settings. 

5. Ensure your Pixel Aspect Ratio is set to Square Pixels.  
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6. Check your Preview File Format is set to I-Frame Only MPEG. 

7. If you want to use this new sequence straight away, give it a Sequence Name and click OK.  

Step 2: Saving your Sequence as a Preset 

Once you know your most regularly used sequence settings, you can create custom presets to save 

you time when you need to set up a new sequence. 

1. Follow the steps to create a custom sequence. 

2. When you’re ready, select Save Preset. 

3. Select a name for your preset, give it a Description then click OK. 

4. Premiere Pro will then reload all of the Sequence Settings. 

5. Find the Custom folder, and select your preset. 

6. Name the sequence and click OK. You’re now ready to edit. 

Part 4: Working With Multiple Sequence Settings 

Some projects might need multiple sequence settings, especially if you want to export in different 

formats. For example, you may need to export the same video in 1920x1080p for YouTube and 

1080x1080p for Instagram.  

In this situation, you can just change the export preferences, and the video will be cropped accord-

ingly. However, this might mean that your clips and titles are not framed as well as they could be. In 

cases like this, you can change the sequence settings to adjust your clips. 

Step 1: Edit and Duplicate your YouTube Sequence 

Since your 1080x1920p version of the video will show more of the footage than the square format, 

edit this version first:  

1. Once you have finished your editing, find the sequence in the project browser. 

2. Right-click and select Duplicate Sequence. 

3. Rename the Sequence and double-click to open it. 

Step 2: Adjust your Sequence Settings 

1. With the new sequence open in the project, go to Sequence > Sequence Settings. 

2. Change the sequence to the new settings (for example, changing the frame size) and hit OK. 

3. Adjust the footage in the sequence so that it’s framed how you would like.  

4. You now have 2 sequences containing the same video, ready to export in the various formats 

you need. You can create as many different sequences as you need in a project, just remem-

ber to name them, so you know what they are. 
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While Premiere Pro’s sequence settings can be tricky to navigate, hopefully, you now have the tools 

you need to master them. Despite the many options available, you will likely only ever need to use a 

handful of them. Now we have shown you how to customize your sequences, along with the most 

frequently used settings. You can edit away safe in the knowledge that the settings your project is 

built on are correct.  

Copy and Paste Effects in Premiere Pro 

Copy and paste is one of the most fundamental and necessary skills in various video editing pro-

grams, and Premiere Pro is no exception. Knowing how to copy and paste effects, keyframes, color 

correction, and other edits quickly and efficiently can help you save a lot of time. 

How to Copy and Paste Effects in Premiere Pro? 

There are two methods to copy and paste effects in Premiere Pro. You can do this by using the Paste 

Attributes feature or copying and pasting the effect properties manually. Let’s start with the Paste 

Attributes option, which is the simplest approach to copy an effect from one clip to another if you 

want to transfer all effects. 

Follow the steps below to learn how to copy and paste effects in Adobe Premiere Pro using the 

Paste Attributes feature: 

Step 1: Select the footage you would like to copy from. 

Step 2: Right-click the selected footage and hit Copy. This will copy the footage itself as well as its 

effects and attributes. 

Step 3: Right-click the footage you need to copy to. 

Step 4: Select the Paste Attributes option. If you are using the Ctrl + V shortcut, you will paste the 

entire footage, replacing your other one, while you are using the Paste Attributes feature, you only 

paste the effects and edits. 

 

How to Copy and Paste Keyframes in Premiere Pro? 

In addition to learning how to copy and paste effects in Premiere Pro, it’s also crucial to figure out 

how to copy and paste keyframes in Premiere Pro. Here’s how to do it: 

Step 1: Select the keyframes you wish to copy. 

Step 2: Right-click the footage you need to paste and select Paste Attributes. 
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Step 3: You’ll see a new window asking you what attributes you want to paste. To paste only 

keyframes and not other edits, select only Time Remapping. 

How to Copy and Paste Color Correction in Premiere Pro? 

Instead of pasting all of the effects, you might transfer only one specific edit, like copy-pasting only 

color correction to other footage. This is where choosing which effects to paste comes into play. Do 

the following: 

Step 1: Select the footage that you’ve color corrected. 

Step 2: Go to the Effect Controls panel and locate Lumetri Color options. 

Step 3: Right-click the Lumetri Color settings and hit copy. 

Step 4: Open your new footage and go to the Effect Controls panel again. 

Step 5: Right-click and click on copy attributes. 

Create a Montage in Adobe Premiere Pro 

Photo montages are a great way to show still images in a captivating way on video, whether it’s re-

capping your family vacation or presenting a new program at work. By adding music, transitions, and 

the Ken Burns effect, you can link your photos together to tell an exciting story for the viewer.  

Step 1: Setup Preferences in Premiere Pro 

Before you get started editing your video, it helps to set up Premiere Pro with the default settings 

you’d like to use for your montage. 

1. Navigating to Preferences > Timeline, here you can choose 2 important settings for your pro-

ject. 

2. Adjust Still Image Default Duration to the number of seconds you’d like each image to display 

in your montage. We recommend between 3 – 5.  

3. Adjust Video Transition Default Duration to the number of seconds you’d like transitions to 

last. Usually, .5 to 1 second is plenty.  

4. If your images are really large—like your stock photos from a DSLR camera—you might want 

to scale them down to prevent slow-down. You can do this by navigating to Preferences > Me-

dia and setting Default Media Scaling to “Scale to Frame Size.” 

5. Press OK to close Preferences. 

Step 2: Import Your Images & Add Them to the Timeline 

After choosing your defaults in Step 1, it’s time to import and arrange your photos in the order you’d 

like to show them in the video. 

1. Set up your Project and Sequence. 

2. In the Project Browser, right-click and select Import. 
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3. Navigate to the folder storing your images and click Import. You can select multiple images 

and import them all at once.  

4. Arrange your photos into the order you’d like to show them by dragging and dropping them in 

the project browser.  

5. Select all the images and drag them over to the timeline together. 

Step 3: Scale & Position Your Images 

Unless all of your images are exactly the same resolution as your video, you’re going to need to po-

sition them a little bit manually. Luckily once you place one, you can copy & paste that change to the 

rest of your images.  

1. Move the playhead to the beginning of your timeline and select the first image. You may notice 

it’s either too big or too small for the video. That’s okay; you’ll adjust the size next.  

2. In the Effects Controls tab, adjust the number to the right of Scale until the image fills the 

frame appropriately. 

3. You might also want to adjust the Position of the image, so the subject is framed properly. The 

2 numbers to the right of Position are the X and Y coordinates of your image, and changing 

them will move your image around in the frame.  

4. From here, you can highlight your clip in the Timeline and copy it by pressing Control C (Com-

mand C on Mac). 

5. Drag to select all the images in the timeline, then right-click and select Paste Attributes.  

6. If some of your images are different sizes or orientations, you may need to repeat this step 

for those images. You can always Copy & Paste the attributes from one clip to another.  

Step 4: Add Music & Transitions 

Choosing the right song will set the mood for your slideshow and keep viewers engaged. Check 

out Motion Array’s library to find the perfect royalty free music track. 

Premiere Pro also has several built-in transitions to help animate your montage. We used Cross 

Dissolve in the example below, but you can browse the available transitions and use whichever you 

prefer.  

1. Import a song in the Project Browser and drag it into the timeline, so it starts with the first 

picture.  

2. If your song is longer than your slideshow, press C to use the Razor Tool and cut the song 

right at the end of your last image. Now press V to switch back to the Selection Tool. Select 

the clipped segment that goes beyond the end of your montage and press Delete on your key-

board to get rid of it.  

3. In the Effects tab, search for Transitions, this should display a number of results.  
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4. Inside Audio Transitions, expand the Crossfade folder, then drag “Constant Power” to the end 

of the song in your timeline. This will give the song a nice fade-out at the end.  

5. Back in the Effects tab under Video Transitions expand the Dissolve folder. Right-click Cross 

Dissolve and set as default transition.  

6. In the Timeline highlight all of your images and press Control D (Command D for Mac) to apply 

transitions between all your images 

Part 2: Pro Tips When Making a Photo Montage 

The steps from the first half of this article will build you a basic photo montage quickly. But if you’ve 

got a little more time on your hands, we have a few tricks to take your video to the next level.  

1. Simulate Camera Movement with the Ken Burns Effect 

The Ken Burns effect simulates camera movement to breathe life into still images. This technique is 

widely used whenever editors need to show still images in a video. Just follow the steps below to 

create your own Ken Burns effect.  

1. Move the playhead to the first image in your timeline, in the middle of the clip between the 2 

transitions. 

2. In the Effects Controls tab, inside the Motion menu, click the stopwatch icon besides Posi-

tion and Scale to enable keyframes for those 2 properties.  

3. Create keyframes for Position and Scale by clicking the grey diamond to the right of each. The 

diamond should turn blue. 

4. Drag the keyframes you’ve just created to the beginning of the clip. 

5. Adjust the Position and Scale properties again slightly. You can simulate camera zoom by ad-

justing the scale, or simulate panning and tilting by adjusting the Position. Premiere Pro will 

automatically animate the motion between your first and last keyframes.  

6. Drag the keyframes you’ve just created to the end of your clip. 

7. Once you’re satisfied with the effect, highlight your clip in the Timeline and copy it by pressing 

Control C (or Command C on Mac).  

8. Now you can highlight the other clips in the timeline, right-click them and select Paste Attrib-

utes. 

9. In the Paste Attributes pop-up, make sure Motion is selected, then press OK. Your motion ef-

fect will be applied to all the clips you’ve selected. 

10. You might want to repeat this step with different images in your timeline to create some vari-

ety in the motion. 

2. Cut to the Beat of the Music 



Video Editing  96 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

You may want to synchronize the cuts in your photo montage to the beats in the song you’ve se-

lected. This will create a rhythmic visual effect like a music video, and can be accomplished easily 

using Markers and the Automate to Sequence feature in Premiere Pro. 

1. Load your song into the timeline. 

2. Move the playhead to the beginning of the timeline and press M to create a marker for the 

first frame. You should see a green marker appear above the timeline.  

3. Now press Space to play the song and tap the M key on your keyboard in time with the beats 

you’d like your photos to transition on. Try not to do this too often, no faster than once every 2 

seconds. 

4. Move the playhead back to the first frame of the Timeline. 

5. Select your imported photos in the Project Browser and press Automate To Sequence. 

6. Change Placement to at Unnumbered Markers to have your pictures placed at the markers 

you created.  

7. After you’ve added the footage to the timeline, you can continue on Step 3 from Part 1 above.  

3. Create a Parallax Effect  

By isolating the subject from its background and animating them separately, you can create an ex-

traordinary parallax effect in your montage. The ideal candidate for this effect is an image where the 

subject is close to the camera and surrounded by a faraway background. Here’s how you do it: 

1. Choose the image you’d like to use and if it’s not already there, drag it to the timeline where 

you’d like it to appear in your video.  

2. In the Effects Controls tab under Motion, adjust the scale of the image so it fills the frame, but 

is still at least 10% larger than your video. This extra space around the picture will be used to 

create motion in the image.  

3. In the Timeline, hold Alt and drag the image to the track above itself to create a copy. Press 

the Eye button to hide the track with the original image, and select the new duplicated image 

in the Timeline.  

4. Back in the Effects Controls tab, choose the Pen tool under Opacity. 

5. Now move over to the Program Monitor and place a series of dots outlining your foreground 

object. The last dot you place should be on the first dot to close the shape mask.  

6. You should now see just the foreground object against a black background. Bring back the 

background by clicking the Eye icon to the left of the original image’s track on the timeline.  

7. Now to animate the 2 layers against each other. Select the first image (the background) and 

enable scale keyframes by clicking the stopwatch icon next to scale in the Effects Con-

trols tab.  



Video Editing  97 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

8. Create a keyframe at the beginning and end of the clip, and decrease the scale of the ending 

keyframe by about 10%. 

9. Now with your foreground clip, do the same thing but increase the scale towards the end of 

the clip about 10%. 

10. If your edges are not perfect and there are some background artifacts in your foreground 

layer, you may want to select the foreground clip and increase the Mask Feather property in 

the Effect Controls tab.  

Audio Editing In Adobe Premiere Pro 

A perfect video recording can bring the best shots to impress your viewers, but an im-

age alone is not enough. Audio plays a significant role in video editing because you 

can deliver a whole new atmosphere just by adding background music. 

Step 1. Import Video and Audio Clips 

Gather all videos and audio for your project. It’s crucial to verify all your clips are in a 

format that Premiere Pro supports. Once 

everything is organized on your computer 

or external storage drive, open Premiere 

Pro and start a new project. 

Go to File > Import or use CTRL+I or Com-

mand+I to import your clips. Search your 

media on the windows and click Open. 

All video and audio clips will display in 

the project area, where you can edit them 

or drag them to the timeline to begin the 

audio editing. 

Step 2. Create A Sequence 

Select the files and audio and add them to 

the timeline to create a sequence by drag-

ging and dropping them or by selecting File > 
New > Sequence. 

With your sequence ready, you can move the 

clips in the audio track to adjust where it 

should start. You can have multiple audio 

clips in a track. 
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Step 3. Organize Your Audio Workspace 

To keep your audio clips organized, you can add 

each type of sound and music to separate audio 

tracks and rename them by type of sound. For 

example, you can add all dialogue clips to a track 

that you can rename to “Dialogue,” all sound ef-

fects to a track renamed “Sounds”, and back-

ground music to a track named “Music”. 

In this way, it’s easy to edit background music in-

dependently from dialogue or sounds without af-

fecting all audio clips in your project. To change a track’s name, right-click it, select 

Rename, and enter the new label. 

You can also change the clip’s colour to stay or-

ganized within the audio tracks. Right-click on 

the clip, then select Label, and then a colour. 

Something everyone loves about Premiere Pro is 

its customizable audio workspace. 

Step 3. Cut, Trim, and Crop 

You can use the Razor Tool (press the C key) to 

split the audio track and click where you want to cut. It’s an easy tool but can be hard 

to use when you need an exact cut. 

The other method to cut a clip is using the playhead. Move it to the point where you 

want to cut the audio track and use the 

shortcut CTRL+K or Command+K. 

Trimming is when you cut an audio file 

to shorten it. For example, if you need a spe-

cific section of a song for the intro, you trim 

the clip to the length required. To trim a clip, 

place your cursor at its start or end. When 

the cursor changes, click and drag to trim 

your audio clip. 

Remember that the cut will affect both tracks if your video and audio are linked. To 

unlink them, right-click on the clips and select unlink in the dropdown menu. Now you 

can edit the audio without affecting the video track. 
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Step 4. Adjust Gain and Audio Levels 

If some parts of your audio clips are too low or loud and the project needs to sound 

better, you can quickly fix the volume 

in the timeline using the vertical line 

in the middle of a clip. Select it and 

drag it up and down to increase or decreases volume. 

To adjust input gain, select the clip with right-click, 

and choose Audio Gain. You can set the gain in the 

Audio Gain dialogue box by typing the values in dB. 

Click OK to close the window. 

Step 5. Audio Effects: Crossfade Transitions 

Premiere Pro offers many audio effects, including EQ, de-

lays and echo effects, and crossfade transitions. You can 

use effects in your audio clips to create smoothers transi-

tions between scenes, or fade-ins and outs to the begin-

ning or end of a clip. 

First, ensure you have the effects panel active in Window > 
Effect. Once it’s visible on your audio workspace, search 

for Audio Transitions > Crossfades. Select the transition 

you want and drag it to the desired audio clip. 

Advanced Tips for Working with Audio in Premiere Pro 

Until now, I’ve been going through the basic steps of audio editing, but it’s time to step 

into more advanced features of Premiere Pro. This section will focus on keyframing, 

the essential sound panel, third-party VSTs, audio normalization, and the audio track 

mixer. 

Keyframing 

Keyframes allow you to control the vol-

ume of audio clips or create a ducking 

effect to increase and decrease audio at 

different times in the video. Let’s create 

a ducking effect for a speech section of 

your video where you want the back-

ground music to be lower. 
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Use the playhead to place it where you want to start ducking the music, and select the 

Pen tool (or press the P key.) Create a second keyframe using the Pen tool where you 

want the audio to return to the original volume. Adjust the volume automation by 

clicking and dragging the keyframes up and down to increase or decrease audio lev-

els. 

Preview the track and return to the Pen tool to create more keyframes if needed. 

Essential Sounds Panel 

With the essential sounds panel, you can tag 

each audio file as an audio type: dialogue, 

music, sound effects, and ambiance. Defining 

every kind of audio will give you access to a 

specific set of tools to adjust individual pa-

rameters for each audio type and achieve 

the best possible mix. 

Production VST Plug-ins 

Adobe Premiere allows you to use third-party audio 

production VST plug-ins. For instance, you can use 

our Wind Remover plug-in in Adobe Premiere Pro to 

reduce wind noise from your video. 

 

The first step is to go to Premiere Pro Preferences > Audio. At the bottom, click on 

Plug-in Manager. From there, you can select the folder with CrumplePop VSTs in-

stalled. Now click on Scan for plug-ins and wait until it’s finished. When the scan is 

complete, all plug-ins will be listed there. Click OK to close the window. 

All third-party VST will be available to use in your audio effects panel. Search for 

them, click and drag them to your clip and adjust controls in the plug-in interface. 

Audio Normalization 

Audio normalization is a tool that will make all your audio play at the same volume 

level. It’s useful when you record interviews individually, and the volume differs for 

each audio clip. 

To use audio normalization, select the audio clips with right-click and choose Audio 

Gain. At the bottom of the Audio Gain dialogue, you’ll see Premiere Pro determines the 
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peak amplitude for those audio clips. Now you can select Normalize peaks at a spe-

cific value under 0dB. 

Audio Track Mixer 

From the Mixer, you can do many things you’d do in 

a digital audio workstation (DAW): you can record 

audio directly from Premiere Pro, change the 

track’s name, manage audio channels, use panning 

for sound effects, add effects to the whole track 

(instead of adding effects for each clip), control 

volume, create a submix, and keep an eye on clip-

ping. 

15 best sound design software  

Digital Audio Workstations 

The first thing any sound designer needs is a digital audio workstation or DAW. This is 

your mission control, the place where everything will come together to create your fi-

nal product. 

Pro Tools 

Avid’s Pro Tools has long been a darling of 

the audio production and for good reason. 

This feature-packed workstation can handle 

everything from music production to foley 

for film and TV and everything in-between.  

Logic Pro 

Logic Pro is another favorite of sound de-

signers who favor the Mac OS. Developed by 

Apple, Logic Pro is designed to work seam-

lessly on Apple products and can even be 

used with iPad’s and iPhones which can be 

used like tactile control boards.   

Audio Editor 

Audio editors fall into a slightly different category from DAW’s in that they are slightly 

more suited to audio polishing and finishing as they work with a stereo audio file 
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instead of a combination of audio files. They also offer features that some DAW’s do 

not like pitch stretching. 

Adobe Audition 

Adobe Audition sits in a sweet spot between 

DAW’s and audio editors. It has tons of fea-

tures and if needed, can function as your 

all-in-one audio production workstation, but 

it can also be used in tandem with your 

DAW as your dedicated audio editing and 

mastering program.  

Plugins & Modular Software 

Plugins are where things get really fun. Depending on what you’re designing sound for, 

plugins offer unique sounds that can be bent and manipulated to your heart’s content 

until you have the perfect sound element for whatever it is you may be creating. 

iZotope 

You’ll want to save this page, be-

cause iZotope has a suite of handy 

plugins that will allow you to mod-

ify vocal effects, pitch, speed, tim-

ing and a host of other effects.  

  

Vienna Smart Spheres 

Vienna is most known for their beautiful or-

chestral samples, but with video game au-

dio production on the rise, they’ve begun to 

stretch their boundaries and offer more fu-

turistic audio sampling.   

Ambition 

Ambition is a visual “virtual instrument” that can 

be used to create harmonic mixes and textures 

perfect for designing ambient sounds and 

scores.  
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Favored by trailer music producers, Ambition is the perfect synthesizer tool to have in 

your toolkit for mixing emotional synth scores. 

Cinesamples 

If you’re mixing soundtracks for TV, film, or 

video games, you’ll want Cinesamples.  

Its sample library of crystal-clear virtual in-

struments delivers orchestra samples worthy 

of Carnegie hall, allowing you to create sound-

tracks that sound like they were created in a 

concert hall, not a CPU. 

Weaponiser 

If you’re a video game or action film sound de-

signer, Weaponiser is literally your secret weapon. 

Its library of samples includes weapons, footfalls, 

whooshes and a ton of other dynamic sounds that 

can be layered and manipulated to create totally unique sounds that can fit any pro-

ject.   

Evolution: Devastator 

Designed with video game trailers and sound-

tracks in mind, Evolution: Devastator is your 

heavy metal synth soundtrack platform for 

sculpting darker, grittier textures. This collection 

heavily relies on industrial samples, with over 

200 sounds that include everything from heavy 

machinery to passing trains.  

Valhalla SuperMassive 

Valhalla SuperMassive is freeware that 

packs a punch. This reverb plugin is so 

powerful and controllable, it’s mind-

blowing that Valhalla released it for 

free.  
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Krotos Concept 

So far the best soft-synth modulator we’ve 

found, Krotos Concept is a fast, intuitive 

platform that allows you to create every-

thing from zippy traditional synth sounds to 

more complex sound textures.   

Saturn 2 

If you love the “golden age” of rock and roll, 

you’ll love the Saturn 2 distortion plug-in. It of-

fers distortions that mimic the vintage sounds of 

tube, tape, and guitar amps and gives every-

thing from instruments to vocals that classic 

vintage feel.   

Reaktor 6 

This absolute playground of sample 

sounds by Native Instruments is a fan fa-

vorite time and time again. This custom 

synth building tool works seamlessly 

alongside other plugins from Native In-

struments as the ultimate sound designer 

sandbox.   

Komplete 13 Bundle 

Speaking of Native Instruments, if you truly want 

to take your modular system journey into the 

stratosphere, the Komplete 13 bundle is the way 

to go. With over 36,000 sounds included in this 

bundle, there is literally a sample for every single one of your needs, whether you’re 

mixing for a swelling romantic ballad or a crunchy heavy-metal feel.  

Multi camera editing In Adobe Premiere Pro 

There are three main ways to use multicam editing in Adobe Premiere. This guide will 

walk you through syncing cameras with timecode, in points, and manual syncing in the 

timeline. It will also show you how to edit in the timeline using your new multicam se-

quences. 
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1. Syncing with Timecode 

During production, you have the option to jam sync timecode to all of the cameras us-

ing a smart slate. 

Jam Sync: The process of locking syncing timecode on the camera to the timecode on 
the external audio recorder.  

Make sure the slate is clearly visible on every 

camera. 

After importing your multicam clips in the Project 

Window, select all of your multicam clips. Right 

click on the selected clips and select “Create Multi-

Camera Source Sequence”. 

A dialog box will appear. You will have the option to 

name your new Multicam Sequence. 

Click on the Timecode button under the Synchronize 

Point options and click OK.   

 After selecting Ok, Premiere will create a Multicam 
Sequence. The individual clips will be automatically 

placed in a bin titled “Processed Clips”. 
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Syncing with In Points 

After importing your multicam clips into the 

Project Window, mark the “in point” on each 

clip in the Source Window. Mark the in point 

exactly where the clapper snaps. 

After marking your in points, select all of 

your clips in the Project Window. Right click 

and select “Create Multi-Camera Source Se-

quence”. 

 A dialog box will appear. You will have the op-

tion to rename your new Multicam Sequence. 

 

  

Click on the In Points option under the Syn-

chronize Point menu. Click OK. 

  

 

  

After selecting OK, premiere will create a new 

Multicam Sequence. The individual camera 

clips will automatically be placed in a bin titled 

“Processed Clips.” 
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Manually Syncing Multiple Cameras 

After importing your multicam clips into the 

Project window, Create a New Sequence. 

Insert or Overwrite CAMERA A onto the time-

line on track V1. Overwrite CAMERA B on top of 

CAMERA A on track V2. Line up the WAVE-

FORMS in the audio tracks to sync up the two 

camera angles. 

Repeat this step for any other cameras you 

have recorded (CAMERA C, CAMERA D, etc). 

 Once you are ready to create a multicam se-

quence out of your manually synced cam-

eras, check that the LINKED SELECTION but-

ton is toggled to OFF. This will prevent the 

program from Nesting your audio 

when you create a multi camera 

sequence. 

Select all of your camera angles in 

your timeline. RIGHT CLICK and 

select NEST. 

  

Name this Nested Sequence “MULTICAM NEST” so you can keep track of your se-

quences. Premiere will automatically create a new sequence for you in your Project 

window, and you will notice that your camera angles have collapsed into one track 

(Track V1). 

 RIGHT CLICK and select MULTI-CAMERA > ENABLE. 
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Editing in the Timeline with Multicam Clips 

Create a new sequence in the Project Win-

dow (Cmd + N). Overwrite or insert the 

multicam file into the new sequence. 

 In the Program Window, click the wrench 

icon and select Multi-Camera. 

  

 

  

 

  

While playing the sequence in the timeline, select the various camera angles in the 

Program Monitor window by clicking on the thumbnails of each camera. As you click 

on each image, Premiere will record these angle changes as cuts in your multicam 

sequence.   

We recommend enlarging the Program Moni-

tor window for ease of editing. 

When you stop playback, you will notice cuts 

on the sequence in the Timeline where you 

switched the camera angles. You can alter 

these cuts made by Premiere like any other 

clip; use the pointer, ripple tool (B), or rolling 

edit tool (N) to refine edit points in the se-

quence.  

Editing music videos 

If you choose a song that is inconsistent in its volume, you’ll have a harder time edit-

ing it into your video. Similarly, selecting a track with lyrics can cause issues under 

dialogue, so knowing how to edit your track is vital for a consistent and engaging 

sound mix. 
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Decrease frequencies instead of volume 

Music is essential to telling an engaging story but can often be distracting under dia-

log. When learning how to edit a song in a video, many editors will lower the volume 

of the music track, but this isn’t the best way to achieve a clean audio mix. 

Humans speak between about 1200 and 1800 Hz, while the music comes from a much 

more comprehensive frequency range. By playing around with the different frequen-

cies, you can carve out a space on your music track for your voice to naturally sit in, 

allowing all the details to be heard. 

1. Edit your video and add your chosen track below it in the timeline. 

2. Hit C on your keyboard to use the Blade tool and create cuts in the track at the 

start and end of each section of the dialog. 

3. In the Effects panel, search for Simple Parametric EQ and add it to the sections 

covered with dialog. 

4. Select the section and go to the Effects Controls panel. 

5. Adjust the Q to 4 and the Boost -18. 

6. Play around with the Center settings to match the speaker’s vocal range –be-

tween 1200 and 1800 Hz. 

7. Right-click on the Simple Parametric EQ effect in the Effects Controls panel and 

choose Save Preset. 

8. Name your preset something easy to find – it will appear in your Effects Control 

panel, ready to drop onto any other track sections. 

9. Finally, add a small crossfade between the sections so the track adjusts when-

ever there is no dialog. 

Cut to the music 

Cutting up your music track is a fantastic way of making it feel like the track has been 

composed specifically for your project, and there are a few ways you can cut your mu-

sic tracks to suit your editing style. 

Cut on downbeat 

Cutting the track allows you to match your edits to the beat of the music. If, for exam-

ple, you’ve found the perfect track but it doesn’t time up with a ‘moment” in your video, 

you can use this method to achieve your ideal edit. 
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1. Find the downbeat in the track you want to time your edit to. 

2. Using the Blade tool, splice the track on the downbeat. 

3. Delete the start of the track, and drag the end portion to match your edit. 

4. Grab the beginning of the audio track and drag it out to fill the rest of your time-

line – your video will now cut in time to moment in the track you’ve chosen. 

5. Add a crossfade to the start of the track so it comes in gradually at the begin-

ning. 

Cut before the downbeat 

As hard as you try to cut exactly on the downbeat, it may seem slightly out to you 

when watching it back. Our brains receive audio and visual information at different 

speeds, so even if it is only a fraction of a second, it will feel ”off” somehow. 

To solve this, try moving your edit to cut just before or after the track’s downbeat. 

Don’t worry – you don’t need to re-edit your whole timeline. 

1. Highlight all the clips or portions of your track you want to move by one frame. 

2. Hold Control/Command and use the left or right arrow keys to move your high-

lighted portion one frame at a time. 

Cut the audio 

Sometimes, it is best to cut the music entirely, and this technique has several ad-

vantages when it comes to helping you tell your story. Cutting the music suddenly is a 

fantastic technique for highlighting a point in your video, for emotional impact, for em-

phasizing a moment, or for making a joke. 

1. Always cut your track on a downbeat so that the abrupt stop feels natural. 

2. Using the Blade tool (C), splice the track where you want to make an edit. 

3. Move the second portion of the track along the timeline to when you want the 

music to kick in again. 

Manually rearrange your track 

Sometimes, the only option is manually rearranging your entire track to fit your edits. 

As with any manual editing process, this can take some time, depending on how ex-

tensive your project is. However, this method will help you create a seamless track 

with your visuals. 
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For this technique, you need to have a basic understanding of how music is con-

structed. All songs will follow a beat that repeats over and over again. This might be 

4/4 or 3/3, but you should be able to identify the beat pattern by listening carefully. 

You can also look at your Audio Waveform, as the beat often stands out as a repeating 

peak in the wave. 

You can cut entire sections from a track, duplicate sections, and reorder them as long 

as you follow the beat pattern.  

1. Once you have identified your beat pattern, for example, 1, 2, 3, 4, go through 

your track and cut on the number 1 beats. 

2. Rearrange your track as needed, ensure the beats always follow 1, 2, 3, 4. 

3. Add small crossfades between the sections where the difference in the other in-

struments is noticeable. 

Echo out 

You might need to find a track to match if you want to create an abrupt and dramatic 

ending to your video. However, with the Studio Reverb effect, you can make any track 

feel like it’s ended naturally. 

1. Find a downbeat in your track where you want the piece to end. 

2. Create a cut in your track just before and just after the downbeat. 

3. Delete the end of the track so you are left with the start and a tiny section with a 

single downbeat – we’ll call this the echo section. 

4. Right-click the echo section of your audio clip and choose Nest. 

5. Double-click the section to open the nested sequence. 

6. Hold Alt and drag the echo section to the track below to create a duplicate. 

7. Right-click and enable, stretch as long as you want 

8. In the nested sequence, fade out the track. 

9. Go back to the main sequence and increase the length of the section. 

10. Find the Studio Reverb effect in the Effects panel and add it to your echo section. 

11. In the Effects Control panel, click the Edit button. 

12. In the pop-up panel, choose from the Presets menu. 
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13. Play around with the settings until you find the echo style you like. 

Remix tool 

If you don’t have time to play around with your track’s arrangement manually, the 

Premiere Pro Remix AI tool is the simplest and quickest way to edit your song. 

1. Click and hold on to the Ripple Edit tool in the toolbar and choose Remix tool 

from the drop-down menu. 

2. Grab the end of your music track and drag it to your desired length. 

3. In the Essential Sound panel, find the Customize drop-down. 

4. Play around with the Segments and Variations setting until you have a remix 

you’re happy with. 

Understanding the Titler in Adobe Premiere Pro 

The Tilter in Adobe Premiere Pro is a multifaceted, feature-rich text-and-shape crea-

tion tool. You can use it to build text and two-dimensional geometric objects—of any 

size, color, or style—with borders, beveled edges, shadows, textures, and sheens. 

Titler-designed text and objects can be superimposed over video as static or rolling 

credits or used as stand-alone clips. Text and objects created in the Titler are called 

titles.  

1. The screen and menus where you build and view text and graphics. The gray-

scale, checkerboard background denotes transparency.  

2. That is, if you place text or graphics created in the Titler on a video track above 

other video clips in a sequence, the video clips on lower numbered tracks will 

be visible wherever you see that checkerboard.  

3. Title Properties panel: Text and graphic options such as font characteristics, 

strokes, and shadows.  

4. Title Styles panel: Preset text styles. You can choose from dozens of styles or 

customize your own. 

5. Title Actions panel: Align, center, or distribute text and groups of objects. • Titler 

Tools panel: Define text boundaries, set text paths, and select geometric shapes. 

Titler main panel  

6. Titler Tools panel Title Actions panel Title Styles panel Show Background Video 

button Title Properties panel 
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This activity gives you a look at the text properties 

you can work with in the Adobe Premiere Pro Titler. 

After you complete this guide, you can learn how to 

create text and shapes for your projects in the “How 

to build text and objects in the Titler” guide. In a later 

project, you’ll work with extra features such as 

strokes (inner and outer borders), sheen, gradients, 

and rolling and crawling text. 

To examine text properties: 

1. Start Adobe Premiere Pro and open any project. 

2. Select File > New > Title. 

The New Title dialog box appears (Figure 2). 

3. Give your title a name and click OK. 

The Titler appears. 

Note: The background of the Titler main panel can be 

set to display the video frame at the current location of 

the CTI in the Timeline. To toggle the video background 

on and off, use the Show Background Video button (Fig-

ure 1). 

4. To create a text title, click the Type tool—the large T in 

the upper-left corner of the Titler Tools panel (Figure 

3). 

5. Click anywhere inside the Titler main panel screen, type some text, press Enter 

(Windows) or Return (Mac OS), and type a second line of text. 

You have two lines of text in a bounding box (Figure 4).  

6. Open the Font pop-up menu (at the top of the 

Titler main panel) and select a different font 

(Figure 5). 

The text in the Titler main panel changes to the 

new font. 

 

Add Subtitles & Captions in Premiere Pro 

What is the difference between subtitles and closed captions? 

Figure2 New Title dialog box 

Figure3 Type tool 

Figure4 A two-line title 

Type tool 
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At first glance, closed captions and subtitles appear to be the same; they both have 

text on the screen to let the viewer know what is being said. However, there are sub-

tle differences, the main one being who they are intended for.  

Subtitles 

Subtitles display any spoken information; character dialogue, voice-over and narra-

tions. Subs are intended to be a written transcript of your video and are super helpful 

for language translation and accessibility for those that don’t have audio. Most social 

platforms now auto-subtitle your videos when you upload them, giving the viewer the 

option of turning them on and off. 

Closed Captions 

Closed captions are subtitles with more details; they don’t just transcribe the spoken 

word but any other important audio information, such as music, sound effects and 

background noises. Closed captions are intended for those with no audio input, such 

as the hearing impaired. 

Where subtitles tell the viewer what is being said, closed captions interpret the audio 

world of your video, indicating tone, emotion, and pacing. Subtitles will often be edited 

from the spoken word to improve the clarity of the message, such as removing stut-

ters, umms, and errs. Closed captions often include these dialogue stumbles to aid 

anyone that might be lip reading with following along. 

How to add subtitles in Premiere Pro 

Premiere Pro offers one of the most comprehensive and robust subtitling and closed 

caption tools across all professional editing suites. In fact, with Premiere Pro, subti-

tling is so easy it does a whole step for you. 

1. Edit your video; your subtitles should be added last.  

2. Go to window> Text; under the Captions file, click Transcribe Sequence. 

3. In the Create Transcript box, the appropriate audio track from the drop-down. 

4. Choose the language you’d like to transcribe; you can add multiple speakers if 

more than one person is speaking in your video. 

5. Once you’re happy with the settings, hit Create and wait for Premiere to tran-

scribe the video. 

6. Read through the transcription, making any adjustment to text the Premiere AI 

has gotten wrong. 



Video Editing  116 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

7. Once the transcription is done, click the Create Captions button at the top of the 

box. 

8. In the pop-up window, ensure Create Captions from Transcription is selected 

and any other settings you wish to use. 

9. Hit Create, and Premiere will add your captions to the timeline. 

10. Highlight all of your titles and use the Essential Graphics panel to adjust the 

subtitles’ font, weight, size and color. 

How to add closed captions in Premiere Pro 

Fortunately, adding Closed Captions to your videos in Premiere Pro uses the same 

method as the Subtitles, but you may need to do a little more editing. Premiere doesn’t 

allow for 2 Caption Tracks, and since the transcription will only include the spoken 

words, you will need to go through and add in any other audio information you deem 

necessary. 

There are 2 ways to add a new caption that isn’t created through the transcription; as 

a part of the original subtitle or a new title. 

Option 1: Adding a caption to an existing subtitle 

1. Find the Subtitle in the Text panel that you want to add an audio description. 

2. Right-click on the title and choose Add New Text Block to Caption. 

3. Type your audio description into the new box; it will be added to the transcription 

titles. 

Option 2: Add in a new title 

1. To add a new title, you must first ensure there is space for it. 

2. Drag the ends of your subtitles in the timeline to lengthen or shorten them. 

3. Drag the title element down the timeline if needed. 

4. When you have enough space, right-click the Subtitle in the Titles Panel. 

5. Choose Add Caption Before or Add Caption After, depending on your needs; if the 

title is still grayed out, it means you need more space to add one. 

Remember, moving your titles might cause problems with the timing of your dia-

logue/subtitles. 

How to import captions and subtitles into Premiere Pro 
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If you’ve already got a transcript on hand because you’ve used something like an AI 

transcription service, you can easily import the file into Premiere Pro. Riverside even 

has a Premiere Pro integration making it extra easy to seamlessly export your tran-

scription directly into the Premiere Pro timeline. 

  

Regardless of where you got your transcripts, here’s how to import them into Premi-

ere Pro: 

  

1. Click Create Captions, then select Import Caption from File 

2. Drag your .SRT file directly into your project workspace. Premiere Pro will auto-

matically recognize the file format and incorporate the captions or subtitles ac-

cordingly. 

3. You might need to adjust the alignment of your captions with the audio in your 

project. This can be done by modifying the length of your captions track to syn-

chronize with the audio content. 

How to customize subtitles and captions in Premiere Pro 

Once you’ve added subtitles or captions to your video in Premiere Pro, it’s time to tai-

lor their appearance to suit your project’s style. Here’s how you can customize subti-

tles and captions using the tools available in the Essential Graphics panel: 

  

• Font: Start by selecting the caption you want to stylize. Navigate to the Essential 

Graphics Panel and choose a font that resonates with your video’s aesthetic 

from the drop-down list. You can fine-tune the font size, adjust paragraph align-

ment, and even tweak the spacing between characters to achieve the desired 

effect. 

• Position: If you’re looking to experiment with caption placement, head to the 

‘Align and Transform’ options. Here, you have the flexibility to adjust where your 

captions appear using the ‘Zones’ box or by manually inputting your preferred 

horizontal and vertical positioning. 

• Appearance: Go to the ‘Appearance’ section in the Essential Graphics panel to 

modify aspects such as color, thickness, background, or shadow to align with 

your video’s theme and mood. 
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• Animation: Add a dynamic element to your captions by incorporating animations 

or effects. Transform your captions into ‘source graphics’ by navigating to 

Graphics and Titles > Upgrade Caption to Graphic, allowing you to infuse motion 

and visual interest into your subtitles. 

• Setting styles: Streamline your workflow and maintain consistency across your 

captions tracks by creating a caption ‘template’ or track style. This allows you to 

save your preferred settings, including font, alignment, and color, for future pro-

jects. By applying a track style to one caption, you ensure uniformity across all 

captions on that track, saving time and enhancing visual coherence. 

How to export captions and subtitles from Premiere Pro 

When you export your video with subtitles, they are burned into the composition; they 

can’t be turned on/off by the viewer. Additionally, as platforms such as YouTube offer 

an auto subtitling tool, you can end up with 2 versions of subs on your video, making 

them difficult to read. 

Fortunately, these platforms will 

also let you upload the subtitles 

file alongside your video. That way, 

you get complete control over the 

titles, but they are still optional for 

the viewer. Each platform will have 

a slightly different method to up-

load these files, but Premiere Pro 

makes it super easy to download 

them. 

 

1. After completing your video project in Premiere Pro, navigate to File > Export > 

Media to begin the export process. 

2. Choose your desired file format for exporting. Consider whether you want to ex-

port open or closed caption files. 

1. Closed Caption Files: Select ‘Create Sidecar File’ during export to generate 

a separate caption file (.srt, .stl, etc.). These files accompany your video 

and allow viewers to toggle captions on or off as needed. 
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2. Open Caption Files: Opt for ‘Burn Captions into Video’ to embed the cap-

tions directly into the video itself. This ensures that the captions are al-

ways visible and cannot be turned off by viewers. 

Import & work on image sequence 

Step-1 

From the main interface of Adobe Premiere Pro, click 'File' at the top left of the 

screen, then select 'Import'. 

Step-2 

Navigate to the folder with your images in sequence. Opening the folder will display all 

your images in order.  

Step-3 

Choose the first image in the directory. It will be highlighted. Next, go to 'Options' at 

the bottom left of the dialogue box and tick the 'Image Sequence' checkbox. 

  

(This procedure is based on Adobe Premiere for Mac; if you're using Windows, option 

placement may differ. You might find it at the bottom of the dialogue box.) 

Step-4 

While only the initial image will be highlighted, selecting 'Image Sequence' directs the 

software to utilize all images in the folder sequentially to combine and convert into a 

video. 

Click 'Import', and Adobe Premiere will generate the video at the default frame rate 

(Frames per Second), which can be modified as desired. 

You now have a raw .mp4 or .mov file. There are numerous options available to refine 

and tailor the clip according to your needs.  

Step-5 

Drag the new video file onto the timeline. A blue marker at the beginning of the video 

track will appear. Use this marker to scrub through the video. The play button is also 

available to preview the clip. 

The blue marker assists in pinpointing editing locations on the timeline, adding effects 

or incorporating audio as desired. 
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Step-6 

For color adjustments or media additions, simply move the blue marker to your tar-

geted edit point, where you can then opt to introduce various media elements, such as 

motion graphics. 

Step-7 

Approaching the culmination of your project, prepare your clip for export.  

Select the desired video format, verify both audio and video are selected for export, 

designate the export file destination, confirm resolution settings, adjust the bitrate, 

and finalize the export of your project.  

Graphic tab In Adobe Premiere Pro 

The Essential Graphics Panel in Adobe Premiere Pro is a tool that allows users to 

create and edit graphics directly within the program. This panel was designed to sim-

plify the process of incorporating graphics into video projects. It provides a range of 

features such as the ability to add text, shapes, and logos to videos, as well as the 

ability to animate these elements.  

The panel also allows users to browse and use templates for graphics, which can be 

customized to fit the specific needs of a project. These templates can be created in 

Adobe After Effects and imported into Premiere Pro, or they can be created directly 

within Premiere Pro itself. The Essential Graphics Panel is a powerful tool for video 

editors, enabling them to enhance their projects with professional-looking graphics 

without needing to switch between multiple programs. 

How to use the Essential Graphics Panel in Adobe Premiere Pro? 

The Essential Graphics Panel in Adobe Premiere Pro is a tool that allows you to create 

and customize graphics such as titles, lower thirds, and motion graphics. To use it, 

first, open the Essential Graphics Panel by going to Window > Essential Graphics. 

Then, click on the "Browse" tab to view the available templates. You can also use the 

search bar to find specific templates. Once you've found a template you like, drag and 

drop it onto your timeline. 

Markers and Labels in Adobe Premiere Pro 
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Markers are tabs that let you identify important parts of the video with either a color 

or note. In effect, they work similar to sticky notes in real life. The feature is 

ideal for keeping yourself organized in Premiere Pro. 

When using markers, these will not render out with your video during export. So, you 

can use them freely without impacting the finalized project. 

Adding a Marker in Premiere Pro 

To add a marker in Premiere Pro, tap 

the M key on your keyboard wherever you 

have a panel with a timeline selected. You 

will find a new marker at the playhead, 

which you can label appropriately. 

You can also use the Add Marker button un-

der either monitor. 

If you do either of the above while a specific clip is selected, Premiere Pro will apply 

the marker to the clip itself—not the timeline. This allows you to move the clip around 

while taking the marker along with it. 

You will notice that the marker you've applied 

to the clip in the timeline will also feature on 

the clip in the bin. Hopping over to the source 

monitor will reveal the marker in its place. 

You might want to use this feature when 

syncing sound to a video. 

Use too many markers and you may find that 

your project is difficult to manage. If you don't 

need one anymore, you can right-click on it. 

After doing this, you'll see a menu with a list of options. Choose either Clear the Se-

lected Marker or Clear All Markers, depending on your preference. 

How to Use Markers in Premiere Pro 

When working with markers, you need to remember two primary windows: 

• The panel titled Markers. 

• The Marker Editor window. 
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You will find the Markers panel alongside Ef-

fects, Metadata, and so on. Before doing any-

thing else, access the panel dropdown menu 

by clicking on the three horizontal lines. 

You can work in two modes here. When Show 

all clip Markers in sequence is enabled, you'll 

see a chronological list of all of the markers 

in the sequence. 

If it isn't, you will only see markers applied to the clip you have selected. If nothing is 

selected, this panel will be empty. 

This panel is useful because it allows you to watch the entire project uninterrupted. 

When you see something you want to fix, tap M on your keyboard so you can go back 

later. 

The text field indicated by the magnifying glass at the top-left corner of the panel is 

where you can search your tags in order to pull up what you need. This will make it 

easy to put your first assembly cut together. 

How to Change Marker Labels 

By double-clicking one of your markers in 

the timeline, you will be see the Marker Edi-

tor window. Here is where you can apply 

color labels, and label different tasks with 

different colors. 

You can also assign each marker a name. 

Other options include adding metadata and 

keywords to the comment section, which 

will help you navigate through your assets. 

Moreover, you can adjust the marker's duration. 

Use Marker Labels to Improve Your Video Editing Workflow 

Forgetting parts of a video you need to edit is frustrating, but you can improve your 

editing skills significantly with markers. Though underused, this feature is one of the 

most essential to know when using Adobe Premiere Pro. 
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Color Grade In Premiere Pro 

Adobe Premiere Pro offers a wonderful array of features for colorists and dynamic 

syncing with the Adobe Creative Cloud suite of products such as After Effects and 

Photoshop. This post will go over coloring for video production in Adobe Premiere Pro 

for Mac and Windows devices, perfect for those looking to up their coloring workflow. 

The Lumetri Color Panel 

The Lumetri Color Panel in Premiere Pro is where you’ll find all of your color grading 

tools. Premiere Pro is broken up into a few 

different workspaces. These workspaces 

can be accessed by going to Window > 

Workspaces. 

This will bring up a drop-down menu con-

taining a slew of customizable workspaces 

like Audio, Editing, Motion Graphics, 

and Color. Clicking on Color will provide 

you with all the tools you need to begin 

coloring your clip. 

The Lumetri Color Panel is located on the right-hand side of the screen and contains a 

few different submenus. 

Basic Correction 

The Basic Correction window has a few very simple 

color effects and is a great starting point for coloring 

your clip. 

 

• Input Lut: The input Lut gives you a few different 

LUT templates to choose from. An input LUT en-

hances your footage and is incredibly useful if 

you’re shooting in a LOG (or flat) color profile. 

• White Balance: The White Balance gets rid of any 

weird color casting that may be present in your 

footage and helps render white as being - well - 

white. Ever see footage that has a super orange 
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or blue tint to it? This is probably due to the white balance being incorrect. 

Both temperature and tint will help fix this issue. 

• Saturation: The saturation of your image is how vibrant the colors are. An image 

with no saturation will appear black and white whereas an image with incredibly 

high saturation will have colors that pop. 

• Exposure: Exposure is simply how much light your image has in it. A video with 

low exposure will look incredibly dark and muddy whereas a video with high ex-

posure will be bright 

• Contrast: What contrast does is increase the distinction between lighter and 

darker areas of your image. 

• Highlights: This slider changes how bright and contrasty the bright areas of your 

image are. 

• Shadows: This slider adjusts how bright and contrasty the dark areas of your 

image are. 

• Whites: What this slider does is adjust how bright and contrasty the white areas 

of your image are (usually the same as your highlights but now always). 

• Blacks: This slider adjusts how 

bright and contrasty the black ar-

eas of your image are (usually the 

same as your shadows but not al-

ways). 

Creative 

Underneath the Basic Correction tab is the Creative Window. The Creative Window 

gives users a few more options that add a bit more flare to their videos. 
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• LUT: The Creative Lut (or look-up table) gives the pic-

ture a much more unique flare. Premiere Pro has a 

myriad of presets, but there are also plenty of plugins 

available online for you to play with if you so desire. A 

LUT gives a certain look or feel and is often synony-

mous with color grading as opposed to color correc-

tion. This is what can give a “cinematic look” to your 

footage. 

• Faded Film: The faded film slider gives a much softer 

image and washes out the highlights as well as the 

shadows. This is great for filmmakers who are trying to 

fake some sort of a film look. 

• Sharpen: This slider is pretty self-explanatory. Sharpen simply enhances any 

softer pixels to create a crisper image. Sliding this down will make for a softer 

image though. 

• Vibrance: Vibrance enhances colors in the image that are dull. 

• Saturation: Saturation further enhances and intensifies every color in your im-

age. 

• Shadow Tint: The shadow tint is a color wheel that shifts the color of the shad-

ows depending on where you put it. 

• Highlight Tint: The highlight tint is a color wheel that shifts the color of the high-

lights depending on where you put it. 

Curves 

After Creative is the Curves Window. Curves give you much more control over a lot of 

the features covered under Creative and Basic. For 

example, the RGB Curve is used to adjust the con-

trast of your image. A simple “S curve” will boost 

the highlights and darken the shadows. You can 

create a curve by clicking on the line in the middle 

of the color graph. A dot will form that you can drag 

around. Double-clicking this dot will reset every-

thing back to normal. 
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You can adjust the red, blue, and green levels on the graph by selecting the respective 

color at the top of the screen. Using the graph in this mode will accentuate the color 

values. If you’d like, you can white-balance your image by just using this method. 

• Hue vs Sat: This isolates a particular color range and allows for it to be more or 

less intense. 

• Hue vs Hue: What this does is allows you to se-

lect a certain color and change it to another 

color. This is super handy for stylistic content 

(such as music videos or social media clips). 

• Hue vs Luma: This will change the brightness 

of certain areas depending on the range that 

you choose. 

• Luma vs Sat: What this curve does is let you 

change the brightness of a spot based on the satu-

ration. 

• Sat vs Sat: This changes the saturation of certain 

colors of the image which can be incredibly handy 

if a background color is too prominent or not 

prominent enough. 

Color Wheels & Match 

Color Wheels are another way to color your image. They’re very similar to curves but 

in wheel form. The Highlight Curve adjusts the intensity of 

your highlights, the Shadow Curve will adjust the intensity 

of your shadows, and the Midtone curve will adjust the in-

tensity of your mid-tones (which is pretty much everything 

in between your highlights and shadows). 

The color match feature 

found in this window will 

automatically color your 

image based on a refer-

ence image that you feed 

it.  
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Simply put an image or video clip next to the clip you wish to color and click Compari-

son view. Then, click on Apply Match and Adobe Premiere Pro will create a look for 

your image similar to the one that you gave it. 

 

 

 

 

 

 

 

 

 

 

HSL Secondaries 

The HSL secondaries panel is a culmination of eve-

rything looked at so far. You can select specific col-

ors in your image using the eye dropper tool and 

edit or enhance those specific colors using the 

color wheel located at the bottom. 

 

Vignette 

Finally, there’s the Vignette window which lets you 

add a Vignette to your image. All a Vignette does is 

add a soft black or white circle around your image. 

This can be done either as a cool stylistic choice or 

as a way to focus in on a subject. 

The Lumetri Scopes panel 
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The Lumetri Scopes panel is located on the left-hand side of Premiere and can be 

used as a reference to see how over or underexposed your image is as well. There 

are so many reasons to be using scopes while col-

oring. 

Our eyes can only do so much and are far from ac-

curate when viewing colors. Your monitor also may 

not be entirely accurate, requiring you to rely on 

scopes for complete color accuracy. Right-clicking 

on the Scopes panel will let you display a few differ-

ent kinds. 

Waveform Monitor 

The Waveform scope is the default scope and asses the 

brightness of your image as well as specific colors using an 

IRE scale that ranges from 0-100. 

Parade 

The parade splits your image up into RGB values. What the parade does is measure 

the saturation of each of these colors in your image. 

 

Vectorscope 

A vectorscope is incredibly handy for measuring the degree of 

hue and saturation in an image. The further the markings are 

from the center, the more saturated your image and colors are. 

There’s also a line indicating where your skin tones should be. 

Skin tones can often shift green or blue depending on your 

camera, so it’s good to have this indicator to make changes in 

post production. 

Histogram 

A histogram is a graph that measures the brightness of an im-

age by representing the frequency of each tone as a value on a 

bar chart. Your histogram running off towards either hand indi-

cates that either your highlights or shadows are being clipped. 

A histogram is most important when filming and is a great tool 

to have while on set. 



Video Editing  129 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

Color grading workflow in Premiere 

It’s always best to start out with a simple color correction while working. Color cor-

rection fixes any imbalances you may have had while shooting. Things like white bal-

ance, highlights, and shadows all fall under color correction. 

Color grading on the other hand is the more creative side of coloring. Things like sat-

uration, LUTs, and HSL secondary all fall underneath color grading. It’s best to perfect 

your coloring correction first before moving on to color grading. 

Typically, it’s also best to do all of your coloring on an adjustment layer as well. Ad-

justment layers can be created by going to the bin at the bottom left of your screen, 

right-clicking and going to New > Item > Adjustment layer. 

Throw this on top of your footage in the timeline and make color changes to the ad-

justment layer. This will, in turn, also make color changes to whatever is underneath 

it. This way, your original footage stays intact. 

It’s also incredibly important to use scopes while coloring. As stated before, our eyes 

and even computer monitors are incredibly inaccurate. Utilizing scopes ensures that 

your image looks consistent across a wide range of devices. 

 

 

 

Adjustment Layers in Premiere Pro 

Part 1: What is an Adjustment Layer? 

Adjustment layers are a great way of adding effects and color grading to large parts 

of your sequence. They can be found on your Project browser and added to the se-

quence in the same way any other clip or media would. Since the adjustment layer is a 

clip on its own, it can be moved, cut, turned off, or removed altogether in just a few 

clicks. If you have added an effect that you don’t like, you only need to delete it from 

the adjustment layer. 

Adjustment layers are incredibly versatile and allow an editor more time to be crea-

tive. Using one can affect many clips underneath or across an entire edit. Once you 

understand how to use them, you can quickly try things out without worrying about 

undoing it all later. 

Part 2: How to Add an Adjustment Layer to Your Timeline 
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Since adjustment layers can be used with such a wide range of visual effects, it would 

be impossible to show you everything. In this step by step guide, we’re going to use an 

adjustment layer to create an aged film look across our sequence. 

Step 1: Create a New Adjustment Layer 

Before you can add your effects, you need to create the adjustment layer. You can cre-

ate as many as you want or need for your project. 

1. Go to File > New > Adjustment Layer. If it is greyed out, make sure you have se-

lected the Project browser and try again. 

2. You can also click the New Item icon at the bottom right side of the Pro-

ject browser, and select Adjustment Layer. The settings will automatically be the 

same as your sequence, so hit OK. 

3. In the Project browser, right-click on the new Adjustment Layer and select Re-

name. 

4. Name your layer something relevant and hit return. 

Step 2: Add the Adjustment Layer to Your Sequence 

As you will see, the adjustment layer lives in your Project browser alongside your 

other clips and assets. 

1. Select the Adjustment Layer in your Project browser. 

2. Drag and drop it into position on your timeline, making sure it’s stacked above 

any clip you wish to add effects to. 

3. Drag the ends of the Adjustment Layer out to cover the whole area you want to 

apply the effects. 

Step 3: Add Your Color Grade 

It’s a good idea to add any color grading you want before you add the effects as this 

forms the basis for how the clip will look.  

1. Go to the Color workspace. 

2. With your Adjustment Layer highlighted in the sequence, open the Lumetri 

Color panel on the right-hand side. 

3. Make your color Adjustments, remembering every clip below it on the timeline 

will have the effect applied. 
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Step 4: Add Your Effects 

The next step is to add your effects. In this example, we are going to make some color 

changes, add some noise, grain, and a vignette. 

1. In the Effects workspace, search for your chosen effect on the right hand side. 

2. Drag and drop the effect onto the Adjustment Layer. 

3. Adjust the effect settings in the Effects Control panel. 

4. Continue to add and adjust effects until you are happy with the look you have 

created. 

Part 3: Pro Tips for a Trouble-Free Editing Workflow 

As with all processes in editing, occasionally things can go wrong, or behave unex-

pectedly, so we created a list of tips for how to keep your adjustment layers organized 

and trouble-free. 

Always Name Your Adjustment Layers 

Giving your adjustment layers names will be a massive timesaver, especially if you 

are experimenting with various looks. A well-organized project browser makes your 

editing more efficient, and that should be the goal of every editor. 

Color Correct Before You Color Grade 

If you are planning to add color grades to your adjustment layer, it’s vital that you do 

all of your color corrections first. Remember, your adjustment layer will affect every-

thing in the sequence, and your grade will look different from clip to clip. As with any 

editing workflow, you should correct your clips before adding the grade. 

Get Creative Using Keyframes 

As the adjustment layer has the same properties as a clip, you can keyframe effects 

that you would not otherwise be able to keyframe.  

You can use keyframed adjustment layers to create some really cool effects, here are 

our top 3 favorites: 

1. Use the Gaussian Blur effect over your sequence, and keyframe the Blur 

Amount settings. This can be really useful when you need to add titles over your 

footage. 

2. Use the Lumetri Color Saturation controls to create a Wizard of Oz style color 

change; fade between black and white and full color. 
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3. Use the Leave Color effect to slowly fade your sequence to black and white, 

leaving just one color in the sequence. This works really well for music videos 

and events promos, especially if there are a lot of different and bright colors in 

your scene. 

Save Your Work as a Preset 

If you’ve put a lot of time and effort into creating a fantastic effect, you might want to 

use it again for another project. Fortunately, Adobe Premiere Pro lets you save your 

adjustment layer effects as a preset, which will appear in your Effect panel. 

1. Select the Adjustment Layer in the Sequence. 

2. In the Effects Control panel, select all of the effects you want to include in your 

preset. 

3. Right-click and select Save Preset. 

4. Name your preset something relevant and click Save. 

5. In the Effects Control panel, search for your preset. You can now drag and drop 

the preset to any other clip or adjustment layer. 

 

Adjustment layers can be a lot of fun to work with, as they allow you to experiment 

with your growing visual effects skills in a user-friendly way. They can also save you 

time, both in how long it takes you to add and amend your effects, and through handy 

preset functions.  

 

 

Duplicate a person or a Crowd in Premiere Pro 

Part 1: Planning Your Shot 

The technique we are going to show you works best with a bit of pre-production. 

Planning the shots you want to achieve can help make the editing a lot easier and give 

you a better overall result. 

For a clean edit, it helps if your subject doesn’t cross lines of the frame. Start by set-

ting your camera up and lock it in place. Your camera mustn’t move position while you 

are filming, or you will have a lot of problems in the edit. 
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Think about your shot division and where you can place your subject without them 

crossing another space. In the example, we have divided the area into five clear sec-

tions in which our subject can exist. 

 

Next, you need to consider the length of your shot. If each of your clones will have 

specific actions to complete, you should always record for the longest possible action. 

For example, if our main subject has to deliver a script to the camera that is 60 sec-

onds long, we want each take to last approximately the same length. 

Once you know the position and duration of each of your clones, you can begin filming. 

Film the sequence for each of your clones, being careful not to cross the space you 

have allowed for that version. For our example, we would have five separate takes, 

with our subject in a different position for each. 

Top Tip: It can be super helpful also to film your scene without a subject. This clean 

take can be used to patch areas in your end composition if you need to. 

Part 2: How to Clone Yourself in Premiere Pro 

Once you have all your shots imported into Premiere Pro, you can begin to edit your 

composition. 

1. Place all of your clips on the timeline, stacked on top of one another. 

2. Go to the Free Draw Bezier or Rectangle tool and draw around the subject on 

your top layer to create a mask around your subject. You should immediately be 

able to see the second layer below it. If your camera didn’t move during the 

shoot, your layers should match perfectly. 

3. Continue through the layers, masking around your subject, until each clone ex-

ists in its own box. If you have spaces between your masks, you can either ad-

just them slightly or place the clean clip you took of the area at the bottom of 

the stack. 

4. If your clone moves and goes slightly out of frame, you can adjust the Effects 

Control Panel’s Mask Expansion. 

5. You can also blend the lines between your clips using the Mask Feather settings. 

6. Finally, add an adjustment layer above your stack and drag it to the length of 

your project. 
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7. With the Adjustment Layer selected in the timeline, go to the Lumetri Color 

Panel and add a Look to your film to tie it together. You can download 

some awesome free LUTs here. 

Part 3: How to Clone or Duplicate a Crowd in Premiere Pro 

While it becomes more complicated to do, you can also clone groups of people using 

the steps above. You may need a bigger space to accommodate your clone groups, but 

the technique is the same.  

A final element you can add when duplicating a crowd is an in-front of camera shot. 

As you can imagine this is tricky, as your subjects are sure to cross the lines you have 

set, so for this, you will need a green/blue screen. 

1. Film all of your other groups’ scenes as described above. Keep the camera in 

position. 

2. Position your actors in front of the camera, ensuring there is enough depth be-

tween them and your previous shots. 

3. Place a greenscreen behind the actors so that they are not overhanging the 

edge of your screen. 

4. In Premiere, att your in-front-of-camera shot at the top of the stack, and crop 

the edges, so it is just your actors on the plain background. 

5. Go to the Effects Panel and add the Keylight effect to your clip. In the Effect con-

trol panel, use the color picker to select your screen color. 

6. Play around with the edge and feather settings until you are happy with how it 

looks. 

Part 4: Top tips for Cloning 

Make Sure your Subject(s) Don’t Move 

While you want your groups to be moving in the shot, they need to be careful not to 

move into another section of your frame. Like a single clone, the more space you al-

low between each of your sections, the easier the edit will be. It might be helpful to 

your actors to lay our markers so they know where the lines are. 

Adobe Premiere Pro Green Screen Footage Keying 

What is a Green Screen (or Chroma Key)? 
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The green screen is also called chroma key, which is a more accurate term for the ac-

tual process. When you shoot your film, you mask out portions of the shot with a color 

matte and replace those sections with other images during the edit. This results in 

two pieces of footage being played simultaneously, with the top clip being transparent 

in the areas you have keyed out, leaving the bottom clip in its place. 

With chroma-keying, the background doesn’t have to be green. As you are removing 

parts of your shot based on its color, you can, in theory, use any color you like. How-

ever, you do need to be careful about the other elements of your shot. For instance, if 

you shoot an actor with a blue shirt on a blue screen, you’ll end up with a floating 

head. Not a good look! 

Sometimes, the chroma keying needed for a shot won’t be the background. Instead, 

something in the shot itself, like a TV screen, will need to be replaced. In these in-

stances, you can set the background to a green color and later replace it with what-

ever you want in post-production. 

 Color Key vs Ultra Key 

There are two main types of chroma keying: color key and ultra key effects. These 

tools work very differently, but for some pieces of footage may give the same effect. 

Color Key 

Color key is incredibly specific in 

its range, and will only remove 

pixels that are the same hex code 

as your selected color. Even with 

the best possible lighting on your 

green screen, you will not be able 

to shoot your scenes without hav-

ing variants in the color and luma 

of the green background. 

Color key is best used with 

graphics or elements with digitally rendered color that you can remove. If you’d like to 

use the option below, you can find this stock video in the Motion Array marketplace. 

Ultra Key 

Ultra key is what you will need for footage that has variants in tone and shade of the 

background. The tool looks at both the luma (light) and color of the background, 
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allowing you to get impressive results even when the background is underlit or has a 

number of shadows. 

Learn Chrome Key Editing in Adobe Premiere 

Using the Ultra Key 

1. Drag and drop your background footage on to your timeline, then place your green 

screen footage directly above it. 

2. In the effects panel, search for Ultra Key and drag it to your green screen clip. 

3. In the Effects Controls panel, select the color picker and click on the green back-

ground. You’re not quite finished yet, but you can see that this already looks pretty 

good. 

4. Next, swap the output from Composite to Alpha Channel, now you can see the re-

maining background that needs to be removed. 

5. Using the Matte Generation tools, adjust the settings until you have entirely re-

moved the background. The best way to learn is trial and error, play around with the 

settings until you get used to what they do. Remember, all of these settings will affect 

your subject as well as your background. 

6. Finally, add any other effects to your clips to get the foreground to feel like a part of 

the background, for example, color grading, or adding a blur to your background. One 

last tip, make sure you render your timeline to see it playback at full speed. 

Tips & Troubleshooting 

Color Isn’t Important 

While green is the most common background type, it’s vital to consider the other ele-

ments of your scene first. If you want your actor in a green costume, shoot it on a blue 

background. If you choose to film on a green background, ensure that a similar green 

isn’t in the shot. 

Prepare. Position. Perspective. 

It’s quite easy to get some good green screen shots and remove the background. The 

problematic thing is matching the shots to the new background and making it look 

real. 

This process starts at the filming stage. Consider the distance, camera angle, and fo-

cal points of the two layers before filming them. Remember, if you want any type of 

movement in the camera, the movements need to be the same for both shots. 



Video Editing  137 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

Space 

It is always preferable to have a slightly bigger screen than you feel you need. Make 

sure your performers stay inside the green screen. Placing them in the middle of your 

space will also help you avoid the shadowy edges. 

Lighting is Key 

It’s essential to film with as little shadows on the background as possible. Since most 

screens are made from a material, it is unlikely to be crease-free. If you’re noticing 

lots of wrinkles and shadows, you might want to iron the screen before you start. You 

will thank yourself later, we promise! Your replacement background will likely have its 

own light source too. Consider this within your green screenshot and make sure they 

match. 

Transferable Skills 

Chroma keying effects work similarly in both After Effects and Photoshop which al-

lows you to use similar tools to create special effects, motion graphics, and images. 

Chroma keying in Photoshop can be extremely helpful when it comes to creating the 

poster for your film. 

Color Correction & Grading 

Always remember to color correct and grade your clips so that they match. You can 

also add other effects such as a sense of flare and light leaks to help cover any differ-

ences between the clips. 

Chroma keying is a great tool that offers filmmakers endless creative options. Creat-

ing realistic green screen compositions will take time and practice, and involves care-

ful planning before you film. You need to be aware of how the composition will be built 

in post-production to ensure you film the individual elements to work together. 

How to Export Video From Adobe Premiere Pro 

Video exporting might be one of the most overlooked steps in the post-production 

process which is unfortunate considering it may just be the most important. A lot can 

go wrong during the export process, and it’s important you know how to export a 

video to keep your footage looking just as beautiful and as sharp as when you shot it. 

All of the old options found on the previous versions of Adobe Premiere Pro CC are 

still there though with some new features thrown in as well. 
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Step 1: Select the project to export 

The first thing you’ll want to do is open up 

your desired project. Triple-check to make 

sure that everything is in order before begin-

ning your export. There’s nothing worse than 

viewing your finished export only to realize 

that you misspelled a word, colored a clip 

wrong, or missed a transition. 

 

Step 2: Open the export window 

After everything is to your liking, you’ll want to open up the export window. This can be 

down one of three ways. 

The first way is to click “File” and then scroll over the “Export” button and click “Me-

dia.  

The second way is by simply hitting ctrl + m or cmd + m on your keyboard. 

The third way was updated for the 2022 version of Adobe Premiere Pro CC. Next to the 

“Edit” button on the top left of the screen is a button called “Export”. Clicking it will 

bring you over to the export window.  

Step 3: Adjust your sequence settings 

Once inside the export window, you’ll be 

greeted with a wide array of export op-

tions. The export window itself is broken 

down into three columns. 

The column on the left (labeled “timeline") 

shows all of your presets, the column in 

the middle (labeled “settings”) gives you 

all of your metadata and output options, 

and the column on the right (labeled “pre-

view”) shows a playback window of what your project will look like as well as all of 

your important data such as file size and frame rate. 

 

The settings column is the most important one out of the bunch. “File name”, “Loca-

tion”, “Presets”, and “Format” are accessible right away in this column. By default, the 
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preset drop-down menu is set to “Match Source” which will match the sequence set-

tings of your project. 

Clicking on this will open up a drop-down menu allow-

ing you to choose from a small batch of presets. Se-

lecting “more presets” will give you access to hundreds 

of Adobe presets with options to even import and ex-

port your own. 

 

Below this menu are seven different drop-down menus. 

The most important two are “Video” and “Audio”. Inside 

of video, all of the options are greyed out by default. It’s 

best to keep this the same since it matches the settings you chose in the timeline. If 

you’d like to change any of these, it can be done by clicking the checkboxes on the 

right-hand side of the column. 

 

Step 4: Select the format and the codec 

Which codec you choose is one of the most important 

decisions in any export. The “format” drop-down menu 

gives you a lot of high-quality containers to choose 

from. The best export settings will vary from person to 

person depending on the type of project they’re working 

on. 

Generally, H.264, H.265, and QuickTime are the three 

most common video containers people use. There are 

also containers designed specifically to export audio. 

Audio-only exports can be done by selecting containers 

such as MP3. 

 

After choosing your container, you’ll want to go to the “video” 

drop-down menu in order to select your video codec. The codec 

options will vary depending on what container you chose earlier. 

If you’re working within an H.264 container, no codec options will 

be available at all. It’s important to choose a container and codec 
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that fits your needs. Maxing out all of your video options isn’t necessarily always bet-

ter. 

 

Step 5: Adjust the remaining export settings 

A lot of the more advanced video settings can 

be found under the “more” tab in the video drop-

down menu. Here, you can customize things 

such as bitrate settings and encoding settings. 

Most users will be focused primarily on bitrate 

settings. This also changes depending on which 

container you chose. 

The default H.264 container gives a lot of bitrate 

encoding options. Because of that, it’ll be the 

one that we’ll primarily focus on. 

At the top are checkboxes with an option to 

“render at maximum depth” as well as an option 

to “use maximum render quality”. Both of these 

will create a sharper, higher-quality export at 

the cost of a longer export time. 

 

Scrolling down a little bit, you’ll find a section labeled “bitrate settings”. In the bitrate 

encoding drop-down menu, you’ll find options 

for CBR (constant bit rate) and VBR (variable 

bit rate). Below that is a slider where you can 

set your target bit rate. 

 

Chosing between a CBR and VBR depends entirely on your content. CBR is great be-

cause of its consistency. It can be lower quality than VBR in some cases but is perfect 

for things such as live streaming. 

VBR on the other hand is great for uploading 

higher-quality content. VBR, 2 pass provides you 

with a “target bitrate” and a “maximum bitrate”. 
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Something important to note is that your maximum bitrate should also be double what 

your target bitrate is. 

 

A high bitrate doesn’t always mean a great upload though. Sites such as YouTube, 

Vimeo, and even streaming platforms such as Hulu have various different bitrate 

standards. It’s always a good idea to look at the rules and guidelines of your video 

hosting platform of choice before exporting. Adobe themselves has a really 

great guide on what they think the best export settings are. 

Step 6: Name the file and export 

Once all of your settings are to your 

liking you’ll want to give your file a 

unique output name before sending it 

off to export. You’ll also want to 

choose an output location by clicking 

the blue highlighted text underneath 

“File Name”. This will bring you to a 

finder or file window where you can 

choose the output location of your 

export. 

 

In the lower right-hand corner are two export options. There’s a blue button labeled 

“Export” and a button right beside it labeled “Send to Media Encoder”. Clicking “Export” 

will export your file to the destination you chose. Clicking on “Send to Media Encoder” 

will open up Adobe Media Encoder. 

Adobe Premiere Pro vs After Effects 

10 Key Difference Between Premiere Pro and After Effects 

1. Video Tracks 

2. Audio Editing 

3. Keyframe Workflow 

4. Camera Tracking 

5. Timeline Tools 

6. 3D Capability 
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7. Multicam 

8. Digital Alteration 

9. Enhanced Masking 

10. Expressions and Scripts 

1. Video Tracks 

One of the things that makes Premiere Pro such as an easy, breezy video editing soft-

ware is the fact that it’s non-linear, which basically means that it allows you to layer 

multiple pieces of media onto the same track. This might not seem like a big deal, but 

being able to stack your clips in such a way that you can see where all of them are 

sitting at a moment’s glance is an essential component of maintaining a fast, efficient 

workflow. In contrast, with Adobe After Effects, you’re pretty much dealing with a one-

piece-of-media per track situation. So using it for any long-form or media-rich pro-

jects is going to be a straight-up nightmare. 

2. Audio Editing 

With Premiere Pro, you get the full gamut of audio editing tools—audio repair options, 

audio-mixing, snazzy sound effects, auto-ducking, volume controls, the list goes on. 

But with After Effects, it’s a totally different story. While the program will recognize 

any audio that comes attached to visual media, it doesn’t really have the capability to 

do anything with that audio apart from increasing and decreasing its volume. 

3. Keyframe Workflow 

While it is entirely possible to keyframe in Premiere Pro, you’re going to have a much 

easier time and achieve way better results if you use After Effects. Much of this is to 

do with the After Effects interface, the simplicity of which lends itself well to the intri-

cate and sometimes finicky task of keyframing. To top it off, After Effects also comes 

with a dedicated graph display which makes fine-tuning the speed and direction of 

your elements way more smooth and precise. 

4. Camera Tracking 

Another fine feature where After Effects reigns supreme! With its built-in planar and 

3D tracking, After Effects lets you composite titles and objects onto your 2D footage 

then manipulate their movement in such a way that they look totally organic to the 

scene (think of text floating on water or a cloud-like thought bubble appearing above 

a character’s head). Premiere Pro, on the other hand, has virtually no camera tracking 
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functionality. Sure, you can pixelate faces and objects—but the fun pretty much stops 

there. 

5. Timeline Tools 

If you need to string a narrative timeline together, then for the love of all that is holy, 

use Adobe Premiere Pro. Its timeline panel comes chockablock with tools to make the 

editing process quick, easy, and super intuitive. I mean, can you actually imagine how 

long it would take build a sequence without the help of the all-important ripple edit? 

Or the beloved razor? The slip tool? The rate stretch? Well, if you want to find out, just 

try editing one of your projects entirely in After Effects where the timeline tools are 

kinda lacking. 

6. 3D Capability 

When it comes to 3D, After Effects is where it’s at. Not only does it let you track 3D el-

ements into your footage, but it also comes with a 3D renderer that recognizes inputs 

on all three dimensions (X, Y, and Z) so you can create 3D elements from scratch. With 

Premiere Pro, there’s nothing that even comes close to this. Yes, it does offer the 

Basic 3D feature. But this only allows you to simulate 3D movements, not actually cre-

ate them. 

7. Multicam 

If you ever need to edit a multicam project (such as a wedding, concert, or sports 

event), then it’s really going to help if you can view all the different angles simultane-

ously. Well, with Premiere Pro you can do exactly that by setting up what’s called 

multi-camera source sequence. Essentially, this will allow you to view all of your 

synced clips in real-time and pluck the best bits from each one. 

8. Digital Alteration 

It’s often said that After Effects is like Photoshop of video, and never is this truer 

when it comes to digitally altering footage. With After Effects, you can easily remove 

or modify unwanted objects (such as crew members or branded signage) with the 

help of the trusty old Clone Stamp. Basically, the Clone Stamp lets you copy pixel val-

ues from one area of your footage (say a blue sky) and apply them to a different area 

(say a cloud) to create your ideal backdrop (in the case, a cloudless blue sky). Even 

more impressive, After Effects also comes with a wire removal tool, specifically de-

signed to erase support ropes and harnesses from stunt scenes. 

9. Enhanced Masking 
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For those who aren’t familiar, masking is where you grab or rotoscope a section of 

your frame (again, let’s a say a cloud) and select to either include or exclude every-

thing inside of that section. Technically speaking, both Premiere Pro and After Effects 

can mask objects. But realistically speaking, After Effects does a way better job of it 

— the reason being that After Effects comes with all the first-rate tools you need (like 

the Mask Tracker and Track Mask Effect) to carve out objects with insanely (and I 

mean insanely) fine precision. 

10. Expressions and Script 

Say you need to add a little motion expression to one of the objects in your scene. 

Well, the fastest way to do that is with the After Effects Expression Language menu 

which lets you literally type in commands detailing what you want your object to do. 

For example, if you’re going to emphasize a title by making it pulse or shake, simply 

punch in the word “wiggle” followed by the desired value properties and bada bing 

bada boom — your title will be shaking up a storm on cue. (Quick heads up: the Ex-

pression Language menu is based on JavaScript language code, so depending on your 

coding skills, this feature may take some time to get your head around). 

  Premiere Pro After Effects 

Video Tracks X   

Audio Editing X   

Keyframe Workflow   X 

Camera Tracking   X 

Timeline Tools X   

3D Capability   X 

Multicam X   

Digital Alteration   X 

Enhanced Masking   X 

Expressions and Script   X 

What Is Premiere Pro Better For? 



Video Editing  145 By Sardar Azeem 

 

sardar azeem | PICT ABBOTTABAD CONTACT US 0313-5879331 

Editing videos. 

If you need to assemble a video project from start to finish, then please, use Premiere 

Pro. Only with Premiere Pro can you load pile gigabyte after gigabyte of media onto 

your timeline and rest assured that the program has all the features and horsepower 

needed to cut, slice, trim, layer, and rearrange that media into a fully-fledged, fine-

tuned film. Sure, it might not cut the mustard when it comes to perfecting individual 

clips. But what it can do with those clips once they’re completed is where the soft-

ware truly shines. 

 

What Is After Effects Better For? 

Manipulating footage and creating motion graphics and VFX from scratch. 

Where Premiere Pro excels at doing a lot of different things relatively well, After Ef-

fects excels at doing a lot of very specific things, really well. This includes 3D manipu-

lation, camera tracking, stylizing visual effects, advanced masking, and tons more. The 

only thing After Effects doesn’t kickass at; creating stand-alone video projects. That’s 

because in many ways, After Effects is like a brick-manufacturing company, carving 

out the building blocks one needs to construct a home. But when it comes to actually 

building the foundation and walls and roof of that home,  well, you’re going to want to 

bring in the professional who do that best—which is the case of this clumsy analogy, 

just so happens to be Premiere Pro. 

How Do Premiere Pro & After Effects Work Together? 

Okay, so you’re probably beginning to wonder how one goes about maneuvering be-

tween these two programs in their day-to-day workflow. Having to constantly jump 

back and forth between Premiere Pro and After Effects depending on whatever task 

you’re working on sounds like a serious drag. And it absolutely would be, if it weren’t 

for the following two connection points. 

Dynamic Link 

Dynamic Link is a one-way delivery mechanism designed by Adobe to facilitate better 

collaboration between the various program in its suite. Simply speaking, this means 

that by using Dynamic Link, you can select for After Effects and Premiere Pro to talk 

directly to one another and automatically import and sync clips, so you don’t have to 

waste time running back and forth between each program playing the middleman. 
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Say you’re working on a project in Premiere Pro and realize that one of your clips 

needs a bit more finessing in After Effects. All you do is highlight the clip on your 

timeline and right-click on “Replace With After Effects Composition.” This will then 

open up the clip inside of After Effects so you can immediately go to town on it, mak-

ing whatever tweaks need to be made. 

 

 


